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Emails

Oracle Eloqua includes robust email marketing capabilities that you can weave into your

marketing campaigns. Emails remain central to many marketing campaigns. Using email,

you can reach a large number of existing and potential customers efficiently and cheaply.

Email is also reliable and it's easy to report on its performance.

The downside of email marketing is that because it is so inexpensive and easy, nearly

everyone (including your competitors) is using it, and it is hard to get noticed. Therefore, it

is in your best interest to use email intelligently, to consider design and campaign

elements carefully, and to use email as part of a multi-device, multi-channel marketing

approach. It is also important to include personalization to increase identification with

your message and to stand out from every other email that a contact gets. In addition, you

need to ensure that you comply with all applicable regulations and best practices.

Oracle Eloqua provides you with the following email editors to help create your emails:

¤Tip: Learn more about differentiating between these asset types.

l Design Editor: A drag-and-drop interface that let's you easily create fully responsive emails

without touching any code. Learn more about creating responsive emails and using the Design

Editor.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AssetType
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l Source Editor: An HTML code editor that provides you with a live preview and HTML editor. If

you're familiar with HTML code, you can build responsive emails with full access to the

underlying code. Learn more about HTML emails.
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l Classic Design Editor: View-only version of Classic Design Editor assets.

Searching for emails



©2025 Oracle Corporation. All rights reserved 10 of 197

Examples of emails

Emails continue to be at the center of many marketing campaigns. It's important to pay

attention to how design trends in your emails grab recipients' attention. Below are

examples of a few different uses and designs for emails. Each email example is created

using the email Design Editor starting from a template found in your Oracle Eloqua

instance.

Nurture email

This nurture email provides information to recipients and has a simple call-to-action

where they can find additional details. This email could be used as a promotion for the

sale of the eBook, or as part of a larger marketing campaign for the company. Note that

there is a clearly defined link for getting the eBook as well as a link for further information.

This makes it easy for recipients to know what to do, and to carry out an action easily.

Equally as important, the email offers a very concise summary as to why the eBook is
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useful.

This email was created by starting with the 1 Column w/ Button template. The template

layout was not modified. An image and text with hyperlink were inserted. The call-to-

action button was customized by modifying the text, color, and rounding the edges. Learn

more about adding images, hyperlinks, and buttons.

Survey email

This email invites recipients to take a survey. As an incentive, they will receive a report

after completing the survey.

This email was created by starting with the 1:2 Column template. A border was added to

the top image block, and an image block was added below the first text content block. At

the bottom, a text block and section was removed and a button added in the bottom right

column. Learn more about adding images and buttons, and working with content and

layout blocks.
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Newsletter
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This newsletter provides recipients with many resources. By including images and short

descriptions, the recipient can quickly scan the email and click the links for the resources

that interest them.

This email was created by starting with the a blank responsive email. Several layouts

were added to create the general structure of the email. They include many right sidebar

layouts, which contain images and text. Each text section includes several font styles and

easy to find hyperlinks. Learn more about adding images and hyperlinks, and working

with content and layout blocks.
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Creating emails in the Design Editor

It's easy to create rich, responsive emails using the Design Editor. Without touching any

HTML code, your emails will render in many different email clients and across many

screen sizes.

Learn more by watching this video!

To create an email using the Design Editor:

1. Navigate to Assets , then click Emails.

2. Create an email:

l In the classic UI, click Create an Email.

l In the Redwood experience, click Create. In the New landing page drawer, provide the Name for the

landing page. Optionally provide the microsite and vanity URL. Click Create.

3. Choose a template or layout for the email. To build a fully responsive email in the Design Editor,

choose Blank Responsive Layout or one of the layout options.

4. In the classic UI, after choosing a template or layout, the Email Settings page opens. Complete

the email settings and click Design Email.

¤Tip: You can complete the email settings later. Click Design Email to continue.

5. Create your email by dragging and dropping content and layouts. Click the content block to

configure it using the properties.

6. Click Mobile in the menu bar to switch to a mobile view and edit your email content as it may

appear on mobile devices. Learn more about editing emails in the mobile view.

https://www.youtube.com/embed/videoseries?list=PLw7GyH-Hj8cNf6vFCPmSekO9qgi87ghfF
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7. As you make changes, you can undo or redo your changes using the toolbar or standard

keyboard shortcuts.

8. Click Save when you are done.

After you finish:

l Draft errors appear until you have completed all the email settings. Click the error

indicator to view a list of all validation errors. You must resolve all draft errors before you can

send the email.

l Oracle Eloqua tries to validate that all the content in the email is fully responsive. If there are

issues with responsiveness, notification errors appear .

l Preview the email using different contacts and screen sizes.

l Send a test version of your email to see what it will look like on differ email clients and devices.
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Email authoring

It's easy to create rich, responsive emails using the Design Editor. The redesigned user

interface lets you focus on building personalized, visually appealing content without

wrestling with frameworks or HTML code. Using the Design Editor you can create the

refined and marketable emails that are the building blocks to a successful campaign.

ëNote: Not all fonts will render in a mobile client. The more common web-safe fonts

are at the top of the font drop-down list.

Learn more by watching our videos!

Build fully responsive emails

Without touching any HTML code, your emails will render in many different email clients

and across many screen sizes.

Drag-and-drop editing

Easily create great emails using the simple drag-and-drop interface. Place components

on the email canvas and know that your layout will adapt across many screen sizes.

Build compelling email design with ease

New features of the Design Editor make it easier to achieve your desired design.

l New layout templates to help you start building your email

l Create hero images by adding background images to your email layout

l Add preview text to your email to help boost your open rates

https://www.youtube.com/embed/videoseries?list=PLw7GyH-Hj8cOJdMAwjIwjnVVK1Q-xYJsW
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l New standard components allow you easily add buttons, dividers, and spacers

l Easily change the default styles of your email so that you can work faster

Include shared components

Create highly personalized emails for audiences using field merges, shared content, and

dynamic content. It's also easy to identify shared components that could prevent your

email from adapting to screen sizes. Learn some tips to keeping your shared components

responsive.

Preview and test

You can send with confidence when you make use of the preview and test features:

l Quickly view your email in the mobile view and make adjustments for mobile devices

l Preview your email on different screen sizes and by using different contacts

l Send test emails to email recipients so you can verify across your target email clients

Design Editor email support

Many combinations of devices and operating systems may have differing results. The

following email clients and browsers have been identified as the most commonly used

clients and have been tested for responsive or mobile friendly elements.

Desktop Mobile Web mail
Thunderbird 52+Gmail app on Android 5.1+Gmail
Apple Mail 9+ Gmail app for iOS Outlook.com
Outlook 2007+ Mail app on iOS 8+ Microsoft Office 365

iOS 11 Windows 10 Mail
AOL
Yahoo!
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ëNote: Versions of Outlook from Outlook 2007 to present use Microsoft Word to

render HTML email. This can cause problems with email rendering. Try to

determine the version of Outlook most used by your email subscribers and design

and test for that version.

Working with email content components and layouts in the
Design Editor

The Oracle Eloqua email Design Editor uses content components and layouts to help you

build your email.

Content components

Content components are types of elements that you can include in your email. Content

types include text, buttons, images, and more. You can add content to sections of a

layout. Content added to layouts create a content component in your email.



©2025 Oracle Corporation. All rights reserved 19 of 197

Layouts

Layouts determine where you can place content components. Layouts consist of one or

more columns that you can add content components to. Oracle Eloqua provides you with

several layouts that you can customize with content components.

Learn how to work with these design components:

l Adding content components or layouts

l Copying content components or layouts

l Moving content components or layouts

l Deleting content components or layouts

l Resizing columns

l Padding and borders

Adding content components or layouts

After you initially choose a layout for your email, you can add content components and

layouts to customize the email design.
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To add content components or layouts:

1. With your email open, drag content components or layouts to your email.

Copying content components or layouts

To copy content components or layouts:

1. With your email open, click the content component or layout you want to copy.

2. Click .

3. Move the content component or layout to the location you want it.

Moving content components or layouts

You can move a content component vertically or horizontally. You can move a content

component to a new layout. You can move a layout vertically.
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ëNote: You cannot move content component if you are in the mobile view. You can

move a layout in mobile view.

To move content components or layouts:

1. With your email open, click the content component or layout you want to move.

2. Click and drag the content component or layout to the new location.

Deleting content components or layouts

To delete content components or layouts:
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1. With your email open, click the content component or layout you want to delete.

2. Click . You can click to undo your change.

Resizing columns

To resize columns in a layout:

1. With your email open, click on the layout that contains the columns you want to resize.

2. Click on or to decrease or increase the size of the columns.
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Padding and borders

You can add padding to most content components and add borders to both a content

component and layout.

Padding

You can adjust the space around a content component using the padding options

available from the panel. You cannot adjust the padding for a layout.

Borders

Add a border around the content component or layout by turning on borders. For multi-

column layouts, you can adjust the borders for each column.

The border goes around the padding.

Content Blocks

Content blocks are groups of layout containers and cells that can be re-used when

building responsive emails or landing pages. They can be a combination of different cell

types such as text, images, dynamic content, shared content, and more. By breaking

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/Help/EmailEditing/Tasks/WorkingWithContentAndLayouts.htm
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=WorkingWithContentAndLayouts
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down your most commonly used components and re-assembling them to meet the

unique needs of each new email and landing page, you can more quickly create brand-

compliant content with ease.

For example, if you find yourself frequently using a particular portion of an email template,

you can save that section as a content block and re-use it in several emails to achieve a

consistent look and feel instead of maintaining a large template library.

ëNote: To create, edit, and delete content blocks, the Manage Blocks security

action permission needs to be enabled. Users without the Manage Blocks

permission can only use blocks that appear in the Blocks tab. However, if they have

email or landing page editing permissions, they can edit a block after it has been

added. For more information, refer to the list of security action permissions.

Next steps:

Creating a content block

Adding a content block

Editing a content block

Searching for a content block

Locking a content block

Deleting a content block

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/Help/SecurityGroups/ListOfActionPermissions.htm
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Creating a content block

You can easily create content blocks and save them for future use. In addition to

elements like images and text, saved blocks can also include hyperlinks and field

merges.

ëNote: Cloud content cannot be saved into a block. If there is cloud content in a

row, you will not be able to save that row as a block.

To create a content block:

1. Click the layout that you would like to save as a content block and click .

2. Enter a name and click Save.

The content block can now be accessed from the Blocks tab.
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¤Tip: For easier management, it is recommended that you have no more than

50 content blocks.

Adding a content block

When you add a block to the canvas, it retains all applied cell, column, and row styling

from when it was saved. Any default styles present will reflect the defaults of the email or

landing page the block is added to.

If a block contains a hyperlink, that hyperlink will receive a new Eloqua tracking ID each

time it is copied or re-used to prevent duplication in reporting.

To add a content block:



©2025 Oracle Corporation. All rights reserved 27 of 197

1. From the Design Editor, click to navigate to the Blocks tab.

2. Drag and drop the blocks that you would like to use.

Once a block is added to the canvas, it is separated from the original block and can

be edited. Any edits made to the canvas will not impact the original block where the

content came from.

Editing a content block

Once saved, a content block can be edited at any time.

To edit a content block:

1. In the Blocks tab, locate the content block you want to edit and click .

2. Select Edit.
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The Block Details tab opens on the left.

3. You can modify the following settings from the Block Details tab:

l Block Name: Enter a new name for the content block.

l Block Description: Enter a description for the content block.

l Block appears in: Choose whether you want the block to appear in an email, landing page, or both.

l ëNote: If a signature rule, form, or carousel is present, the option to select where the block
appears in will be disabled. Only generic content can be shared across both email and landing

page.

View-only information such as Created by and Last modified by are also displayed here along

with the date and time stamps.
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4. Click if you want to add new content components or layout containers to your block. You

can also edit each individual content component such as an image or text in the existing block

by clicking on it directly, just like you would for any emails or landing pages.

When you are editing a block, it will show the text and color defaults saved from the

original block. However, the default styling will change once the block is added to a

new email or landing page.

ëNote: You can add a maximum of 3 layout containers for each content block.

5. There are additional settings available on the top right of the editor:

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/Help/EmailEditing/Tasks/WorkingWithContentAndLayouts.htm
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=WorkingWithContentAndLayouts
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l Switch between Full and Mobile views.

l Use the arrow buttons to undo and redo your changes.

l If you click Cancel, a dialog will prompt you to save. To save your changes, click Save. To

return to the original content block and undo your changes, click Don't Save. To return to the

editor and continue editing, click Cancel.

l When you are done editing, click Save and Close to save your changes.

Searching for a content block

All content blocks are listed in alphanumeric order in the Blocks tab. You can narrow

down the list using the search functionality.

To search for a content block:

1. From the Design Editor, click to navigate to the Blocks tab.

2. Enter a name or keyword in the search field to find the content blocks you are looking for.
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Locking a content block

Content Blocks are unlocked by default, but you can lock all styling changes and make

certain components uneditable. Once you have locked a block, you can only edit images,

text, hyperlinks, dynamic content, videos, and carousels (for landing pages) without

changing styling, such as colors, background, alignment, or column width. This allows

you to use content blocks while still enforcing brand compliance and simplify content

creation. All other components will be locked and can only be edited if the content block is

unlocked again. Once a locked block is added to an email or a landing page it remains

locked, even if the original block in the block library is subsequently unlocked.

ëNote: Locked blocks are supported in Engage and styling restrictions are

respected. However, Locked blocks are not supported in the Oracle Eloqua Sales

Tools for the Microsoft Outlook add-in. Sales users will be able to edit the locked

block styling.

To lock a block:
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1. From the Design Editor, click to navigate to the Blocks tab.

2. Select Lock Block.

3. Click Save and Close to save your changes and close the content block.

4. Once it is locked, a lock symbol will display on the content block as shown in the following

image:

5. You can easily unlock a block by clicking Edit and disabling the Lock Block feature.

Deleting a content block

To delete a content block:

1. In the Blocks tab, locate the content block you want to delete and click .

2. Select Delete.
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Tips to keep your email responsive

Oracle Eloqua's Design Editor makes it easy to create responsive emails. But reusable

components like shared content or dynamic content can, if not properly designed, break

responsiveness. Reusable components include the following:

l Email headers and footers

l Shared content

l Dynamic content

l Signature layouts

Keep responsiveness in mind

Use these tips to help make reusable components more responsive:
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l Keep your images flexible. When using images in reusable components, you want ensure that

they will scale up and down depending on the screen size. Oracle Eloqua provides a responsive

image setting that ensures images scale properly on different devices.

l Keep your layouts flexible. A reusable component with a one-column design, for example, can

adapt to different screen sizes. If you use tables to achieve more complex layouts, you will have

to consider changing the design or use HTML and CSS code to achieve those same results.

When creating reusable components, the rich text editor checks all content to identify

potential responsive issues. Refer to the potential issues below.

Pay attention to responsive issues

The email Design Editor and the rich text editor checks all content to identify potential

responsive issues. The tool checks the content for the following elements:

l The use of tables. While you might not be able to avoid using a table in your reusable content,

Oracle Eloqua always flags the table because it can be unresponsive.

l Images that are not using the responsive setting. Because an image without this setting might

not scale, Oracle Eloqua flags the image.

l Long text strings. Using long strings of text can flow outside of the display screen. To prevent

such an issue, you can use CSS or force breaks in the string. Again, long strings might not be

an issue with your email, but Oracle Eloqua flags it for review.

These elements could prevent content from adapting well to different screen sizes.

Oracle Eloqua doesn't prevent you from using these elements, but you should verify the

final content on different screen sizes.
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Test your final content

Whenever adding reusable components to your email, it is especially important to

preview and test the final content on many screen sizes and email clients. If you can, find

out how your users are viewing your emails and test to those target email clients and

screen sizes. Learn more about sending test emails.

Creating dynamic subject lines in the Design Editor

You can create dynamic and personal subject lines using field merges and dynamic

content.

l Field merges allow you to personalize content using information from contact records, events,

or custom objects. For example, use a field merge to add a contact's name to an email.

l Dynamic content allows you to create content that changes based on specific conditions. For

example, you can customize an email based on a contact's location or other information in their

profile.

Field merges and dynamic content are reusable content stored in the component library.

Learn more about field merges and dynamic content.

Field merges and dynamic content can be an important part of your organizations

personalization strategy.

To add field merges or dynamic content to your email:

1. With your email open, click to open the Settings panel.

2. Select Insert > Field Merge or Insert > Dynamic Content.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=FieldMerges
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=DynamicContent
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3. Search for the item and then double-click the item you want to add.

4. Add any additional text to the subject line.

5. After you save your email, you can preview the subject line using different contacts.

The name of the field merge that appears in the subject line might not match the name of

the field merge you chose. This happens when a field merge was renamed at some point.

Preview the subject line to make sure you've got the field merge you're expecting.

Adding images to emails in the Design Editor

Create more visually appealing content and convey your brand by adding images.

Images can be inserted in image blocks and as backgrounds for your emails. You can

insert images from the component library and Oracle Content Management (formerly

Oracle Content and Experience Cloud or Oracle CX Content).

Learn more by watching this video!

#_bm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/#CSHID=ComponentLibrary
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=OracleContentExperience
https://www.youtube.com/embed/videoseries?list=PLw7GyH-Hj8cNXJ47l8A0Ky3wMg8YJ0pAA
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¤Tip: Since not all email clients download images by default, be sure to include

alternate text.

Adding images using image blocks

When adding image content, use the following guidelines for image sizes:

Email layout Image size
1 column 600px
2 column 300px
3 column 200px
4 column 150px
2 column, left sidebar 200px and 400px
2 column, right sidebar400px and 200px

To add images to your email using the image block:

1. With your email open, drag the image content to the layout.
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2. Choose whether to browse for the image, or to upload a new one.

l To browse to an image in your image library, click . You can browse images from the component

library and Oracle Content Management. Learn more aboutuploading images to CX Content from

within Oracle. Note that the CX Content option will only be available if it has been enabled.

ëNote: The recent Google Chrome version 84 update contains a default setting in
chrome://flags/ that may prevent the Oracle Content Management integration iframe from

loading. Make sure that Chrome's 'SameSite by default cookies' setting is set to 'Disabled.'

ZImportant: Due to the end of life for Oracle Content Management in December 2025, the
Oracle Content Management integration with Eloqua will be disabled with the 25D release.

Please refer to the Oracle Content Management OCM End of Service Notice for more details.

l To upload a new image, click . The image is uploaded to the image library.

3. By default, Oracle Eloqua auto fits the image height and width proportionality to fit the entire

content block. Use the Image Sizing properties to scale the image and set the image alignment.

Learn more about the Image Sizing properties below.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=OracleContentExperience
https://support.oracle.com/knowledge/Oracle Cloud/2981930_1.html
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4. After you add an image, click the image content block and use the Image panel to format the

image.

After you finish, Oracle Eloqua validates that the image will be responsive. If there are

issues with responsiveness, a notification appears . Click the notification icon to

review the issues. You must change the image source to resolve the notifications. You

must change the image source to resolve the notifications.

Alternate text

Using the Image panel, you can add alternate text to your image. Alternate text allows

you to describe your image for recipients that have images blocked or turned off. Alt text

also helps make an image more accessible to people with disabilities.

Sizing and alignment

Use the Image Sizing options available from the Image panel to change the image

alignment or to scale the image.

l Use the Auto Fit setting to adjust the image height and width proportionality to fit the entire

content block.

l Turn off the Auto Fit setting to scale the width of the image up or down. You can scale the image

up to 100% of the content block. Oracle Eloqua maintains the image's proportions.

l Use the Alignment buttons to align the image to the right or left of the content block, or to center

the image in the content block.

Background color

Set the background color of the content block using the Image panel. You can set the

color using hexadecimal or RGB values.

Linking

To make the image a link, use the Image panel. You can link to:



©2025 Oracle Corporation. All rights reserved 40 of 197

l A landing page

l A file in file storage

l An external webpage

l A system action like subscribing to an email group or opening the subscription management

page

l A new email message

Learn more about the link types.

Padding and borders

Adjust the padding and borders around the content block using the options available from

the Image panel. Learn more about padding and borders.

Adding background images

You can add background images to any layout in the email. For example, create a hero

image and overlay it with content to create your bold layout.

Background images are not supported by all email clients (for example, Microsoft

Outlook). Be sure to preview and test your emails using your target email clients.
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To add a background image:

1. With your email open, click the layout you want to add a background image to.

2. Under Background Image, select whether to browse for the image, or to upload a new one.

l To browse to an image click . You can browse images from the component library and Oracle

Content Management.

ëNote: The CX Content option will only be available if it has been enabled.

l To upload a new image from your machine, click . The image is uploaded to the image library.

3. Add content to the layout if desired.

Adding videos to emails in the Design Editor

You can easily add a static video preview image from Vimeo and YouTube videos. Oracle

Eloqua automatically checks for the appropriate video thumbnail and renders it in the

email along with the appropriate video link. Video content is a great way to increase

engagement with your audience and provides a nice alternative to long form text.

Some video preview images may have dark bars above and below the video. This is

based on the video thumbnail passed from YouTube or Vimeo.

ëNote: Eloqua currently does not embed the video as most email clients don't

support a video embed.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=OracleContentExperience
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=OracleContentExperience
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=WorkingWithContentAndLayoutNew
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To add a video using the Design Editor:

1. Drag the video content component onto the canvas.

2. Click Add Video Link.

3. Paste your video's URL in the Video Link field.

4. When you paste your video link, the following General Properties display:
l Alt text: Alternate text allows you to describe your video for recipients that have videos blocked or

turned off.

l Background Color: Allows you to select a custom background color for your video.
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Sizing and Alignment

Use the Video Sizing options available from the Video panel to change the video

alignment or to scale the video.

l Auto Fit: Enabling Auto Fit allows you to adjust the video height and width proportionality to fit

the entire content component. 

l Scale: If you turn off Auto Fit, you can manually scale the width of the video by percentage.

l Alignment: Lets you align the video to the right, center, or left of the content component.
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Padding and Borders

Adjust the padding and borders around the content component using the options

available from the Video panel. Learn more about padding and borders.

Adding buttons to emails in the Design Editor

Buttons are an effective way to create calls-to-action in your email messages. You can

add a button to a layout section of your email using the Design Editor. Button content is

text only and cannot use images.

Learn more by watching this video!

To add buttons to your email:

1. With your email open, drag the button content to the layout.

2. Click the button content and use the Button panel to style your button and configure the button's

link.

3. Click the button text to change it. Use the text toolbar to format the button text.

https://www.youtube.com/embed/videoseries?list=PLw7GyH-Hj8cMPej1uwq8lsgxdipu2wNwO
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Alignment

Use the alignment options in the Button panel to align the button to the left, to the right,

centered, or the full width of the content component.

Text

Set the button text by clicking the button on the email canvas. You can use the text

toolbar to change the font, size, style, and color of the button text. If you create emails

using a RTL (right-to-left) writing system, the Design Editor gives you the option to write

from right to left to insert your button text. Learn more about writing right-to-left.

Color

Using the Button panel, you can set the button color and the background color of the

content component. To change the color of the button text, click the button on the email

canvas and use the text toolbar to make the change.

Linking

To set the link for the button, use the Button panel. You can link to:

l A landing page

l A file in file storage

l An external webpage

l A system action like subscribing to an email group or opening the subscription management

page

l A new email message

Learn more about the link types.
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qWarning: To avoid issues with buttons rendering in your emails, do not copy and

paste text which contains hyperlinks into your buttons.

Sizing

Using the Button panel, you can adjust the size of the button within the content

component using the Width setting. The following options are available:

l Fit to text: Size the button based on the button text. As the button text changes, the size adjusts

accordingly.

l Fit to width: Size the button to width of the entire content component.

Rounded edges

You can create buttons with rounded edges using the radius settings in the Button panel.

By default a button has square edges (0 radius). To make rounded edges, increase the

radius setting. The radius can be 0 - 30.

Padding and borders

Adjust the padding and borders around the button or the content component using the

options available from the Button panel.
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Button Padding: The space around the text of the button.

Button Border: The border around the button.

Outer Padding: The space around the content component.

Outer Border: The border surrounding the content component.

Adding text to emails in the Design Editor

Use the text content to add text to your email.

To add text to your email:

1. With your email open, drag the text content to the layout.

2. Click the text content component and use the text toolbar and Text panel to change your email

copy.



©2025 Oracle Corporation. All rights reserved 48 of 197

Text

To add text, click the text content component and begin typing. You can use the text

toolbar to change the formatting of the text.

ëNote: Not all fonts will render in a mobile client. The more common web-safe fonts

are at the top of the font drop-down list.

ëNote: The Design Editor sets the line-height in pixels so that emails can render

properly in Microsoft Outlook.

Linking

To add a link, highlight the link text and use the text toolbar buttons.

You can link to:

l A landing page

l A file in file storage

l An external webpage
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l A system action like subscribing to an email group or opening the subscription management

page

l A new email message

Learn more about the link types.

You can format the link using the text toolbar or the default style settings for the email.

Pasting text

You can paste text into a text content component using one of the following options:

l Paste as plain text to remove any rich text formatting from the copy source. Depending on your

browser, you can use Ctrl + Shift + V to paste plain text.

l Paste as rich text to include any formatting from the source. Depending on your browser, you

can use Ctrl + V to paste text with formatting. You should review the content pasted to ensure

the formatting is correct.

Color

Adjust the color of the text or the text content component:

l Set the background color of the text content component using the Text panel.

l Set the text color using the text toolbar.

l Apply a highlight color to text using the text toolbar.
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Padding and borders

Adjust the padding and borders around the content component using the options

available from the Button panel. Learn more about padding and borders.

Field merge

To add a field merge, use the text toolbar.

Adding links to emails in the Design Editor

You can add a link to the following content components:

l Image

l Text

l Button

You can link to:

l A landing page

l A file in file storage

l An external webpage

l A system action like subscribing to an email group or opening the subscription management

page

l A new email message

Learn more by watching this video!

https://www.youtube.com/embed/videoseries?list=PLw7GyH-Hj8cMcCBReTZrRN4RsWFeyc9-B
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¤Tip: Getting an invalid URL error for a blind form submit link could mean that

you're using the wrong URL syntax; the email editors now use tilde syntax.

ëNote: With the 24C release, on August 3rd, 2024 (Pods 1, 2, and 7) and on August

17th (Pods 3, 4, 6, and 8), all links will automatically include the authentication hash

parameter. The authentication hash is added to links in emails at email send time

and to links in landing pages at page load time. For emails sent after the 24C

release, the authentication hash parameter will be added to links within the email

and enforced for redirect links. Any alterations will result in redirect links being

blocked. Please note that Emails sent prior to 24C release will not include the

authentication hash parameter in any links within the email. However, redirect links

will continue to work until Eloqua enforces the authentication hash parameter on

previously sent emails beginning on January 15th, 2025. This means that, on

January 15th, 2025, any emails sent prior to the 24C release and are in a recipient's

inbox that contain redirect links will be blocked due to not having the authentication

hash parameter. Read the product notice.

Adding links to text content

To add a link to a text content component:

https://community.oracle.com/customerconnect/discussion/797565
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1. Add the text content to your email.

2. After adding the copy to the text content component, highlight the text that you want to make a

link.

3. Click .

The Hyperlink panel opens.

4. Add the link details to the Hyperlink panel.

Adding links to images

To add a link to an image:

1. Add the image content to your email and add the image.

2. Click the image content component and add the link using the Hyperlink Properties in the Image

panel.

Adding links to buttons

To add a link to a button:

1. Add the button content to your email.

2. Click the button content component and add the link using the Hyperlink Properties in the

Button panel.

qWarning: To avoid issues with buttons rendering in your emails, do not copy and

paste text which contains hyperlinks into your buttons.
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Link types

The following table describes the types of links you can add to an email.

Type Description

Landing Page Link to an existing landing page in the application. The landing pages

that you can link to are available from the hyperlink library. Learn more

about the Components.

Links to landing pages are tracked by default.

File in File

Storage

Link to a file that has been uploaded to the file storage, such as a PDF

file. Learn more about Components.

Links to files in file storage are tracked by default.

Webpage Link to an external web page. These types of links can include field

merges.

Use the Add tracking for untracked external pages or the Redirect for

untracked pages check box to enable tracking on an otherwise

untracked website.

ëNote: Oracle Eloqua landing pages are tracked by default, no

action is required to track landing pages. If a landing page URL is

detected when adding a webpage link, the tracking option will be

disabled and the URL link will not be displayed in manage links.

System Action Link to subscription management or email viewing options. Often these

links are included in the email header or footer, but can be included in

the body of the email as well.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ComponentLibrary
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ComponentLibrary
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Type Description

System action links are not tracked.

The following system actions are available:

l Add to Email Group: Allows the recipient to subscribe to the email group

for the current email.

l Remove from Email Group: Allows the recipient to unsubscribe from the

email group for the current email.

l Send to Subscription List: Sends the recipient to the Oracle Eloqua

Subscription Management Page where they can manage all their email

group subscriptions as well as globally opt-in or opt-out of emails from your

organization. Learn more about the Subscription Management Page.

l Send to Subscription Page: Sends the recipient to a page that

communicates their subscription status for the email group for the current

email.

l Subscribe to All: Allows the recipient to globally subscribe to all emails.

l Unsubscribe from All: Allows the recipient to globally unsubscribe from all

emails.

l View online version: Allows the recipient to open the email in a web

browser instead.

ëNote: If you use Eloqua's unsubscribe system action link, and

are not sending contacts to a subscription management page, we

recommend that you setup an intermediate unsubscribe page.

This is a landing page created in Eloqua using a template we

provide. When a contact clicks an unsubscribe link, they are

CreatingIntermediateUnsubscribePage.htm
CreatingIntermediateUnsubscribePage.htm
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Type Description

presented this page to confirm the unsubscribe. If you do not use

this type of landing page, contacts can be unsubscribed by email

scanning tools unintentionally. To enable the intermediate

unsubscribe page, update your email defaults.

New Email

Message

Creates a link that when clicked will open a new email message in the

visitor's default email program. This is a also called a mailto link.

This is not available in Oracle Guided Campaigns.

Hiding cells in the mobile or desktop view

With this feature, you can optimize the mobile versions and desktop versions of your

Oracle Eloqua emails and landing pages. When you use Hide in Mobile or Hide in

Desktop on a content component, that component is hidden in the specified view (mobile

or desktop) in a sent email or live landing page, as well as in the Design Editor and the

preview.

ZImportant: This feature is tested in Eloqua's supported email clients and web

browsers. Always conduct your own tests in the email clients and browsers that

matter most to your business. It is advised that your design should gracefully fall

back if the hide feature does not work in a given email client or browser.

For example, does the your email or landing page's content look too crowded in its mobile

version? You could use Hide in Mobile on some of the components to improve your
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email or landing page's readability on mobile devices. Certain content or designs may

only be relevant for mobile and can also be hidden in desktop

Before you begin, note the following:

l The hide in mobile feature is not supported in Sales Tools for Microsoft Outlook.

l Sales users will see the default desktop view only.

To hide a content component for the mobile or desktop view:

1. With your email or landing page open, select either the Full or Mobile view.

Selecting Full lets you use the Hide in Mobile option, while Mobile lets you use Hide in Desktop.
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2. Click on a content component to open its configuration panel.

3. If you are in the Full view, click Hide in Mobile. If you are in the Mobile view, click Hide in

Desktop.
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4. (Optional) After hiding a component for one of the views, switch to that view. For example, if you

hid a button with Hide in Mobile, switch to the Mobile view.

You can now see the new layout for this view of your email, and you can assess if there are any

other components you would like to hide.
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Customizing Design Editor emails and landing pages with
CSS

CSS can be used to heavily customize the layout of emails and landing pages.

Standalone CSS classes allow for more flexibility with email and landing page designs,

and custom styles in the Design Editor. Custom CSS will be reflected immediately in the

editing canvas. It's best practice to confirm your styling in preview mode as well as testing

live.

In this topic, you'll learn about:

l Class names

l Sample code

l Things to consider

Learn more by watching this video!

https://www.youtube.com/playlist?list=PLw7GyH-Hj8cOeeyZ2rlaeSOHxNs7HVskz
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Class names

Use these classes to identify the parts of your email or landing page that you would like to

customize.

Design Editor Element Class Name Description
Text .elq-text-cell This class targets the text in text

cells.
Images .elq-image-cell This class targets image cells.
Button .elq-button-cell This class targets button cells.
Shared rules/signature
rules

.elq-external-cell This class targets both shared
content and signature rules.

Divider line .elq-divider-cell This class targets divider cells.
Dynamic content .elq-dynamic-content-cell This class targets dynamic

content cells.
Cloud content .elq-cloud-cell This class targets cloud content

cells.
Spacers .elq-space-cell This class targets spacer cells.
Custom code cells .elq-code-cell This class targets custom code

cells.
Cells by location .row

.col

.cell

Target specific rows, columns,
and cells.

Sample code

See the following design goals and the corresponding example code samples to achieve

these goals:

Goal Code Sample
Adding
a
webfont

@font-face {

font-family: 'Roboto Slab';

font-style: normal;

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddingTextBoxesToEmails
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddHero
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddButtons
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddingSignatures
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddingSignatures
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddingSpacerAndDividers
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddingDynamicContent
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddingCloudContent
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddingSpacerAndDividers
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=CustomizingEmailWithCode
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Goal Code Sample

font-weight: 400;

src: local('Roboto Slab Regular'),

local('RobotoSlab-Regular'),

url
(https://fonts.gstatic.com/s/robotoslab/v8/BngMUXZYTXPIvIBgJJSb6ufA5q
Wr4xCCQ_k.woff2)

format('woff2');

unicode-range: U+0460-052F, U+1C80-1C88, U+20B4, U+2DE0-2DFF,

U+A640-A69F, U+FE2E-FE2F;

}

@import url('https://fonts.googleapis.com/css?family=Roboto+Slab');

Style
Header
s 1-6

.elq-text-cell h1 {

color: red;

text-decoration: underline;

}

Style
bullets
and
number
ed lists
in text
cells

Unordered list:

.elq-text-cell ul {

color: #666666;

font-weight: bold;

}

Ordered list:

.elq-text-cell ol {

color: #444444;

font-weight: normal;
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Goal Code Sample

}

Linking
to
external
style
sheets

</style>

<link href="http://exampledomain.com/mystyles.css" rel="stylesheet">

<!-- here we are in html, so re-open the style to get back to CSS -->

<style>

Style
specific
cells
using
their
location

.row-0 .col-0 .cell-1 {

color: blue;

}

The editor counts left-to-right, top-to-bottom.
Style
body
text in
every
text cell

.elq-text-cell > div > div {

font-family: 'Roboto Slab';

font-size: 1.3em;

}

Use both <div> elements, otherwise you will style all text in all cells.

Things to consider

l Old Shared Content, Dynamic Content, Header, and Footer content components use the

<font> tag rather than <span>. Newly created component library assets will use the <span>

tag.

l If you use the "em" unit inside the CSS block, it may be scaled up or down to the "px" fonts that

the <div> defaults have been overridden with by styles within the text cell itself.

l Font size for Spacer and Divider cells is default coded to 0.
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l The default styles from the Styles tab, as well as other styles needed for consistent rendering,

are inserted into the document at the column level, via a style attribute.

l Oracle Eloqua prioritizes CSS styling in the Design Editor as such:

1. Styles defined at the local cell level (when you click on a content component and configure it).
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2. Custom CSS (as defined in the Advanced Styles section in the Style panel).
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3. Global defaults (as defined in the Style panel).
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Adding dynamic content to emails in the Design Editor

Dynamic content allows you to create email content that changes based on specific rules

and conditions. For example, you could personalize an email with the recipient's sales

rep information based on the city, state, country, or region specified in the contact's

profile. Dynamic content is reusable content stored in the component library. Learn more

about dynamic content.

Adding dynamic content to an email

To add dynamic content to your email:

1. With your email open, drag the dynamic content to the layout.

2. Click and locate the dynamic content you want to add.

3. After you add the dynamic content, click the content block and use the Dynamic Content panel

to change the background color, padding, and border of the content block. Click Edit to change

the dynamic content itself.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=DynamicContent
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¤Tip: Oracle Eloqua validates that the dynamic content is responsive. If there are issues

with responsiveness, a notification appears . Click the notification icon to review the

issues. You can edit the dynamic content from the Design Editor or from the component

library. As you make changes, review the responsive validation errors in the rich text

editor. indicates that there are no responsive concerns. indicates

that there might be responsive issues.

4. After you save your email, you can preview the email content using different contacts.

Padding and borders

Adjust the padding and borders around the content block using the options available from

the Dynamic Content panel. Learn more about padding and borders.

Background color

Set the background color of the content block using the Dynamic Content panel. You can

set the color using hexadecimal or RGB values.

Text

You can format the text contained in a dynamic content in one of two ways:

l By formatting the dynamic content source. Click the dynamic content block and click Edit in the

Dynamic Content panel. See Dynamic Content for more information.

l By setting style defaults for the email. Learn more about setting style defaults.

Adding dynamic content to the subject line

You can add dynamic content to the subject line of the email.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=DynamicContent
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To add dynamic content to the subject line:

1. With your email open, click to open the Settings panel.

2. Select Insert > Dynamic Content.

3. Search for the dynamic content and then double-click the item you want to add.

4. Add any additional text to the subject line.

5. After you save your email, you can preview the subject line using different contacts.

Adding field merges to emails in the Design Editor

Add field merges to personalize your Oracle Eloqua emails using information from

contact records, events, or custom objects. For example, use a field merge to add a

contact's name to an email or to customize email links and images.

Field merges can be an important part of your organizations personalization strategy.

Learn more by watching this video!

Adding field merges to an email

You can add a field merge to text content.

To add field merges to your email:

https://www.youtube.com/embed/videoseries?list=PLw7GyH-Hj8cNn7hxyYATWHNRnPgujum0y
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1. Add the text content to your email.

2. Click the text content block and place your cursor where you want to add the field merge.

3. Click in the text toolbar.

4. Search for the field merge you want to add using the Field Merge Properties panel.

5. Double-click the field merge in the search results to add it to the text content block. Field

merges appear with yellow highlighting.

6. After you save your email, you can preview the field merge using different contacts.

Adding field merges to a URL

You can add a field merge to an external link.

ëNote: The Design Editor does not use the <span class="eloquaemail">field_

merge_name</span> format for field merges.

To add a field merge to a URL in an email: 

1. Add the text content to your email.

2. After adding the copy to the text content block, highlight the text that you want to make a link.

3. Click .

The Hyperlink panel opens.

4. Click the Web Address URL field in the Hyperlink panel and place your cursor where you want

to add the field merge.
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5. Click Insert > Field Merge and search for the field merge.

6. After you save your email, you can test the field merge using different contacts.

Oracle Eloqua adds the field merge to the URL using a tilde (~) syntax which is HTML-

compliant. In the following example, the field merge is part of a query string:

http://www.example.com&elqTrackId=1234&elqTrack=true&
foo=~~eloqua..type--emailfield..syntax--[field_merge_name]~~

The following list describes the field merge tilde syntax:

l ~~eloqua..type--emailfield identifies that this is a field merge for an email. Do not remove

this.

l ..syntax--[field_merge_name]~~ identifies the field merge name. Oracle Eloqua converts

any spaces or hyphens in the name to underscores (_).

Adding field merges to the subject line

You can add field merges to the subject line of the email.

To add field merges to the subject line:

1. With your email open, click to open the Settings panel.

2. Select Insert > Field Merge.

3. Search for the field merge and then double-click the item you want to add. Field merges appear

with yellow highlighting.
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4. After you save your email, you can preview the subject line using different contacts.

Adding email headers and footers in the Design Editor

Add a header to an email to provide information about your company, display a logo, link

to a website, and more. Headers and footers are reusable content stored in the

component library. Learn more about editing email headers and footers.

To add a header or footer to your email:

1. With your email open, click the header or footer content block.

2. Click or click Replace in the properties panel. Locate the header or footer you want to use.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EditingEmailHeaders
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¤Tip: Oracle Eloqua validates that the header or footer content is responsive. If there are

issues with responsiveness, a notification appears . Click the notification icon to

review the issues. Learn some tips on how to keep your email responsive.

3. Click Edit in the properties panel to change the content of the header or footer itself.

4. Use the properties panel to change the background color of the content block.

Alternatively, you can use the default header and footer associated with the email group.

See Email settings for more information.

Padding and borders

Adjust the padding and borders around the content block using the options available from

the properties panel. Learn more about padding and borders.

Plain text email headers and footers

To view the plain text version of the header or footer, click Edit in the properties panel and

then click Plain Text.

Adding shared content to emails in the Design Editor

Shared content is reusable content snippets that you can create once, then reuse in

different emails and landing pages. It allows you to "build once, re-use everywhere" for

your most valuable common pieces of content. Shared content is stored in the

component library.

To add shared content to your email:
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1. With your email open, drag the shared content to the layout.

2. Click Browse and locate the shared content you want to add.

3. After you add the shared content, click the content block and use the Shared Content panel to

change the background color, padding, and border. Click Edit to change the shared content

itself.

¤Tip: Oracle Eloqua validates that the shared content is responsive. If there are issues

with responsiveness, a notification appears . Click the notification icon to review the

issues. You can edit the content from the Design Editor or from the component library. As

you make changes, review the responsive validation errors in the rich text editor.

indicates that there are no responsive concerns. indicates that there

might be responsive issues.

4. After you save your email, you can preview the email content using different contacts.
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Padding and borders

Adjust the padding and borders around the content block using the options available from

the Shared Content panel. Learn more about padding and borders.

Background color

Set the background color of the content block using the Shared Content panel. You can

set the color using hexadecimal or RGB values.

Text

You can format the text contained in a shared content in one of two ways:

l By formatting the shared content source. Click the shared content block and click Edit in the

Shared Content panel.

l By setting style defaults for the email. Learn more about setting style defaults.

Adding cloud content to emails in the Design Editor

Cloud content is content provided by an external service. Cloud content apps must be

installed by your administrator.

To add cloud content to your email:
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1. With your email open, drag the cloud content to the layout.

2. Click Browse and locate the cloud content you want to add.

3. After you add the cloud content, click the content block and use the Cloud Content panel to

configure it.

¤Tip: Oracle Eloqua cannot validate whether the cloud content is responsive and will
always notify you about possible issues. You should preview and test the cloud content

before sending the email.

4. After you save your email, you can preview the content.

Padding and borders

Adjust the padding and borders around the content block using the options available from

the Cloud Content panel. Learn more about padding and borders.
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Background color

Set the background color of the content block using the Cloud Content panel. You can set

the color using hexadecimal or RGB values.

Adding signatures to your email in the Design Editor

Signatures allow you to add personalized sender information to an email. The email

sender or signature rule will be used to dynamically populate the signature. For example,

use a signature layout to include an image and contact information of the sales rep

sending the email. Signature layouts are reusable and stored in the component library.

To add signatures to your email:

1. With your email open, drag the signature content to the layout.

2. Click Browse and locate the signature layout you want to add.

3. After you add the signature layout, click the content block and use the Signature panel to

change the background color, padding, and border of the content block. Click Edit to change

the content of the signature, or Replace to locate a different signature.

¤Tip: Oracle Eloqua validates that the signature is responsive. If there are issues with

responsiveness, a notification appears . Click the notification icon to review the
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issues. You can edit the content from the email or from the component library. As you

make changes, review the responsive validation errors in the rich text editor.

indicates that there are no responsive concerns. indicates that there might be

responsive issues. Learn some tips on how to keep your email responsive.

Color

Using the Signature panel, you can change the background color of the signature content

block. You can set the color using hexadecimal or RGB values.

Padding and borders

Adjust the padding and borders around the content block using the options available from

the Signature panel. Learn more about padding and borders.

Adding dividers and spacers to emails in the Design Editor

Add dividers and spacers in your Oracle Eloqua email using the Design Editor.

l A divider adds a horizontal line between content components in an email.

l A spacer adds vertical space between content components in an email.

To add dividers and spacers to your email:
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1. With your email open, drag the divider or spacer content to the layout.

2. Click the divider or spacer content component and use the Divider or Spacer panel to configure

the settings and style of your divider or spacer.

Line style

Adjust the line style or thickness of your divider in the Divider panel. You can also

customize the line's color.

Color

To configure the color of your divider or spacer, use the Divider or Spacer panel.

You can set the color using hexadecimal or RGB values.

Size

Adjust the size of your spacer in pixels in the Spacer panel.

Padding and borders

Adjust the padding and borders around the content component using the options

available from the Spacer or Divider panel. Learn more about padding and borders.
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Customizing emails with HTML code in the Design Editor

Add your custom HTML code to an Oracle Eloqua email using the Design Editor. For

example, you can use a code content block to fully customize some of your email's

HTML code.

ëNote: Oracle Eloqua tracking IDs are not added to links posted in the custom

HTML of the Design Editor.

To add custom HTML code to your email:

1. With your email open, drag the code content to the layout.

2. Click the code content block and use the HTML editor add your HTML code. Use the Custom

Code panel to format the content block.
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ëNote: You must click outside of the code content block to preview your changes. If you

need a full feature editor, you should create an email HTML instead using the Source

Editor. Learn more about HTML emails.

HTML guidelines

The code content in the Design Editor is intended for snippets of custom HTML code. If

you need greater control over the email, you should use the Source Editor to create an

HTML email. Learn more about HTML emails.

Here are some guidelines for your HTML code:

l Write HTML code that is standards compliant. For example, be sure to nest and close elements

correctly and use lowercase element names, attributes, and values.

l Avoid using the following HTML elements to a code content block: <html>, <head>, <body>,

<script>, <iframe>, <form>. The Design Editor does not support the use of some of these

elements. Others are not supported by many email clients, are often blocked for security

reasons, and if used could cause deliverability issues.

l Be aware of reserved characters like <, >, and &. These characters make up the HTML

language. If you want them to appear in the content of your email, you must use the entity name

or number instead. For example &lt;, &gt;, and &amp;.
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l Support for CSS properties varies across email clients. Use a CSS compatibility chart to

validate what is supported and test your email against your target email clients.

l To prevent CSS conflicts with Oracle Eloqua:

l Avoid the following class names: .body, .ExternalClass, .button.

l Always name classes to be applied to <table> elements. If you are using tables, note the potential

responsive issues below.

l If your HTML code contains tables or long text strings, a notification appears in the Design

Editor. Tables and long text strings can potentially cause responsive issues, preventing content

from adapting to different screen sizes. Oracle Eloqua doesn't prevent you from sending an

email with these potential issues, but you should test your content on different screen sizes and

against your target email clients.

Padding and borders

Adjust the padding and borders around the content block using the options available from

the Custom Code panel. Learn more about padding and borders.

Background color

Set the background color of the content block using the Custom Code panel. You can set

the color using hexadecimal or RGB values.

Changing the background color of emails in the Design
Editor

There are different areas where you can change the background color of your email. You

can set the color using hexadecimal or RGB values.
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Email background: Change the background color of the area outside of the email

canvas.

Canvas: Change the background color of the email canvas. This is the area that

contains layout and content components.

Layout: Change the background color of a layout. For multi-column layouts, you

can adjust the background color of each column.

Content component: Change the background color of content components.

To change the background of a layout or content component:

1. With your email open, click the layout or content component you want to change.

2. Change the background color using the panel settings.

¤Tip: For multi-column layouts, you can adjust the background color of each column.
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To change the canvas background color or email background color:

1. With your email open, click .

2. Change the Email Canvas Color or Background Color setting in the Email Style panel.

Changing the default font, color, padding, and border
settings

Using the Design Editor, you can change some of the default styles of an Oracle Eloqua

email using the Settings panel. Default style settings include:

l Color: Choose the background color and canvas color. Learn more about these background

settings.

l Canvas Width: Select the canvas width for your email in pixels (600px, 756px, 900px, or

1080px). The default width is 600px width. When a width is selected, the canvas automatically

resizes, with layout and content components adjusting accordingly. Each size is responsive and

fully supported.

l Canvas Alignment: Select left, center, or right alignment. The default alignment is center.

Canvas alignment causes the entire canvas to shift to the far left or right side of the email client.

It does not otherwise affect the layout components or content.
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For example, you may want to change it to left alignment if you wanted the email to resemble a

personal email created with a standard email editor. Note that the canvas alignment won't be

reflected in the editor, but you can see the change in the preview and in the final email.

l Text Defaults: Choose the default font and font color of email copy.

l Hyperlink Defaults: Choose the default color of links.

l Advanced Styles: Add your own web font, or control other advanced CSS styling, to meet your

brand needs. CSS added in the CSS code component will automatically render in the editing

canvas, so that you can see how your CSS is being applied without having to toggle between

preview and edit mode. See the Working with email content components and layouts in the

Design Editor topic for more details.

If you need to, you can customize the background color, font, and hyperlink color of

individual content components.

To change the default style settings:
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1. With your email open, click .

2. Change the settings in the Email Style panel.

Sending an email as plain-text only in the Design Editor

With Oracle Eloqua Design Editor, you can choose to send an email as plain-text only. A

plain-text email does not send any images, formatting, or embedded links and does not

include an Oracle Eloqua tracking pixel. It allows the email to be viewed when the HTML

version cannot be rendered properly. You can set contact preferences so that a contact

receives only plain-text emails. To learn more about setting these preferences for a

contact, see flagging contacts to receive plain-text emails.

ëNote: Plain-text emails do not include a tracking pixel. Without a tracking pixel,

you can only view engagement metrics if a link is clicked.

To send an email as plain-text only:

1. Create a new email in the Design Editor or open an existing one.

2. Click to go into Email Settings.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/Contacts/Tasks/FlaggingContactsPlainText.htm
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3. Under Advanced Settings, click Send Plain-Text only.

Contacts will now receive this email as plain-text.

Editing emails in a mobile view in the Design Editor

It is important to ensure that your Oracle Eloqua emails look right on a mobile device. The

Design Editor provides a mobile view of your email that you can use to preview your email

with a smaller screen size and edit the content. The mobile view sets the width of the

email to 360 px.

When using the mobile view, you can edit the content of the email and copy content

components. However you cannot do the following:

l You cannot add new layouts or content to the email.

l You cannot move content components

The mobile view is a preview of your email on a smaller screen size. To fully test your

email, you should continue to do the following:
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l Preview the email using different contacts and screen sizes.

l Send a test version of your email to see what it will look like on differ email clients and devices.

To preview and edit your email in a mobile view:

1. With your email open, click Mobile in the menu bar.

2. Make your changes.

Writing right to left

If you create emails using a RTL (right-to-left) writing system, the email Design Editor

gives you the option to write from right to left. This option is available when adding text to

a content component or button.

To start writing from right to left:

1. Click on a text content component to select it. Learn more about content components in emails

or .
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2. Click the Right To Left button in the toolbar.

¤Note: If you have existing text in your content component, clicking the RTL butoon will
right-justify the selected paragraph.
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3. Type in your content. It will now display from right to left as you type.
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HTML emails

Oracle Eloqua supports creating emails using HTML code. Using the Source Editor you

can create an email with a combination of HTML code and the standard Oracle Eloqua

elements such as images, signatures, dynamically populated fields, and so on.

Creating emails using the Source Editor

With Oracle Eloqua, you can use the Source Editor to create dynamic and effective HTML

emails using a combination of code, and the standard Oracle Eloqua elements such as

images, signatures, dynamically populated fields, and so on.

To create a new HTML email:
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1. Navigate to Assets , then click Emails.

2. Create an email:

l In the classic UI, click Create an Email.

l In the Redwood experience, click Create. In the New email drawer, provide the Name for the email .

Optionally provide the email group, subject line, and preview text. Click Create.

3. Select the Blank HTML Email template or your own template.

4. In the Source Editor, click Actions, then click Settings.

5. Configure the email settings.

6. Add the content of the email. Learn more about HTML email code requirements, email editor

components, and editing HTML emails.

7. Click Save when you are done.

8. Preview and test your email before adding it to a campaign.

Source Editor components

The Source Editor provide components to build your email. To learn more about the

Design Editor, see Email authoring.

The following table describes the components of this.

Component Description

Image: Add images to your email. Click the icon to open the Image Browser,

then drag-and-drop an image from the browser onto the email canvas.

ZImportant: As of version 85, Google's Chrome is now blocking
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Component Description

embedding mixed content in secure web pages and web applications

served with the http protocol. Mixed content refers to images that

are considered insecure. To resolve this issue for any images in your

source editor email, click Actions > Fix Images. Learn more about

Chrome mixed content changes.

Field Merge: Add a field merge to your email. Field merges personalize

emails by drawing information from specified fields in contact profiles. Click

the icon to open the Field Merge Browser, select the text that you want to

convert to a field merge, then double-click on the field name in the browser.

Hyperlink: Add a link to your email. You can enable text or images as

hyperlinks, you can then configure the link in a number of different ways. A

hyperlink can route your clients to a landing page, a file, a web page, a

system action, or a pre-addressed email that they can fill out and send.

Select text or an image and click the Hyperlink icon, select the check box

next to Enable as Hyperlink then configure the link as needed.

Signature: Add a signature to your email, this can be a standard signature

layout that populates with specific sender information.

Click the icon to open the Signature Browser, then drag-and-drop a

signature from the browser onto the email canvas.

Learn more about signature layouts and signature rules.

Shared Content: This component allows you to add shared content to your

email, this is content that can be reused in multiple Oracle Eloqua assets.

Click the icon to open the Shared Content Browser, then drag-and-drop

shared content from the browser onto the email canvas.

ChromeMixedContent.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SignatureLayouts
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SignatureRules
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Component Description

Learn more about shared content.

Dynamic Content: This component allows you to configure your email to

substitute different content depending on specific rules and conditions.

-Example: You could create a rule to decide which salesperson will

appear as the sender of an email based on the city, state, country, or

region specified in the contact's profile.

Click the icon to open the Dynamic Content Browser, then drag-and-drop

the content from the browser onto the email canvas.

The Responsive Vertical Resizing option dynamically resizes emails built in

the Email Editor based on the content populated in the email (e.g. cloud

content, dynamic content, shared content). This prevents content from

being cut off when a recipient's content is larger than the container originally

configured in the email editor and renders a more mobile-friendly version.

Learn more about dynamic content.

Cloud Content: Cloud content is content that is provided by an external

service. (Cloud content can be added to the browser from Apps in the

Setting area of Oracle Eloqua.) Click the icon to open the Cloud Content

browser, then drag-and-drop the service that you want to add from the

browser onto the email canvas.

If the service needs to be configured, double-click the icon on the canvas,

the Cloud Content Configuration window opens. Enter the required details

then click Save.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SharedContent
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=DynamicContent
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Component Description

ëNote: If you attempt to save the email with AppCloud services which

are not fully configured, you will be prompted to complete the

configurations before you can proceed.

The Responsive Vertical Resizing option dynamically resizes emails built in

the Email Editor based on the content populated in the email (e.g. cloud

content, dynamic content, shared content). This prevents content from

being cut off when a recipient's content is larger than the container originally

configured in the email editor and renders a more mobile-friendly version.

Tools: Click this icon to open the Tools window. This component allows you

to access settings related to component you are working with, or to change

the overall email settings (like page size, alignment, etc.).

Mobile View: Click to view the email canvas in a mobile view. This applies

to the HTML editor only. To preview your finished email on various devices,

see Previewing emails

Using the email Source Editor

You can use the Source Editor to modify and customize an HTML email whether you

have HTML knowledge or not.

Adjust the layout for the preview and HTML panes

The buttons at the top of the editor allow you to toggle between a vertical or horizontal

view.
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You can adjust the size of the panes. Depending on the chosen layout view, drag the

pane divider up and down (for vertical view) or left and right (for horizontal view).

Working with content in the Source Editor

Modify and customize the content in the email using one of the following methods:
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l Enter code directly into the HTML pane: Type HTML code directly into the HTML pane. You can

use standard keyboard shortcuts in the HTML pane.

l Drag Oracle Eloqua components to the HTML pane: Use the icons in the left pane to add Oracle

Eloqua components to your email. Learn more about email components.

After releasing the component, it is converted to code. The preview pane reflects the change in

the code.

To delete code you have added using the method above, highlight the code and press Delete

on your keyboard. You can use standard keyboard shortcuts to cut, copy, and paste or use your

browser's Edit menu).

You can also organize the code with formatting. Learn more.

ëNote: Text boxes cannot be added using the drag-and-drop method above. To add text
to your email, you must manually enter the HTML.
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l Use keyboard shortcuts: You can use standard keyboard shortcuts in the HTML pane to cut,

copy, and paste code.

l Edit elements in the preview pane: As you move your mouse over the elements (sections) in the

preview panel, some elements can be edited directly. If the section is editable, it is highlighted

with a blue background and dashed border.

Double-click a highlighted section to edit it using the Eloqua editor tools. When you are done

editing, click outside of the area and the source code is immediately updated.

ëNote: The only sections that can be edited this way are ones that have a <table> or
<div> tag in the HTML source code. No other sections can be modified in the preview

pane. However, modifications, according to the stylesheet that has been applied to your

asset, can always be made in the source code.

Limitations and known issues

l You cannot group or lock objects in the Source Editor, since the right-click functionality is

disabled. However, in edit mode, you can make other changes using the Tools panel.
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l Modifying content in the live preview pane does not automatically move to the relevant section

in the HTML pane.

l You cannot edit the source code of dynamic content, shared content, and signature layouts

using the HTML pane. To make changes, use the live preview pane.

Responsive HTML email templates

The Design Editor provides various layouts that you can use to build a fully responsive

email. However, you can continue to use the responsive HTML templates. Responsive

HTML templates are available from the Template Chooser in the Mobile Templates

folder.

ëNote: The responsive HTML email templates rely on CSS media queries. Deleting

these from the template will remove the responsive nature of the email.

The following describes the responsive HTML templates:

l Responsive 2-Column Split Header: This template contains a two-column header (the

company logo placeholder on the left and a placeholder for other content on the right, 180x50

px). The body of the email is also divided into two columns. The content within the column
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sections can be modified when creating your email.

l Responsive Multi-Column Top Story: This template is similar to the 2-Column Split Header

template, except for the heading which is shown in a single column of 320 x 60 px size.
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l Responsive 1-Column with Callout: This template is geared towards smaller resolution email

clients (600 px or lower). Within the email template body there are specific guidelines for what

codes and tags to use when adding your content.

-Example: In order to ensure that emails viewed in Microsoft Outlook are rendered
properly, do not use paragraph tags, only "<br>". It is important to follow the rules

provided in order to ensure that your emails render properly in various email clients.
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This template also includes a placeholder for a callout. In the example below, there is a section

that provides information (and perhaps a calendar callout) for an event. You can customize this

section by adding the dates, names and other pertinent information for your email campaign.

l Responsive 2-Column: Finally, the Responsive 2-Column template is used for creating an

email containing text and images divided into a two-column arrangement.
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Editing HTML emails using the Source Editor

After you create an HTML email or upload an email using the HTML upload wizard, you

can edit the contents of the email in the Source Editor. You can use the editor to drag and

drop elements into the code or change the code directly.

ëNote: You cannot edit HTML emails using the Design Editor.

To edit an email in the Source Editor:
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1. With the email opened in the Source Editor, click one of the page view buttons in the upper

right-hand corner of the canvas, the HTML pane opens. You can choose to set the pane to the

right, or along the bottom of the screen, this pane gives you access to the code for the email that

you are editing. .

2. Add or edit the email using one of the following methods:

l Type HTML code directly into the HTML panel. You can use standard keyboard shortcuts in the HTML

panel.

l Click one of the component icons on the left-side menu, locate the element that you want to add, then

drag-and-drop the element into the code at the desired location on the code panel.

After the element is released, it is converted to code and the preview pane reflects the change in the

HTML code.
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ëNote: If you use dynamic content, shared content, or signature layouts in your HTML
email, the source code that displays for this content is limited. You cannot edit this

content (for example, its dimensions) directly via the source code editor.

Instead, right-click the content on the left design panel, click Edit, and then edit that

content in its respective editor. Learn more about editing dynamic content, shared

content, and signature layouts.

3. Click Save.

Uploading HTML emails or templates

You can upload an HTML file or a ZIP file that contains your HTML as well as any

associated content (images). If you have created an email outside of Oracle Eloqua using

HTML, you can upload the file to Oracle Eloqua then edit the content in the Source Editor.

Before you begin:

l Make sure your code adheres to the code requirements for HTML email uploads.

l Do not use JavaScript. It is not supported on most email clients and Oracle Eloqua will prevent

uploading HTML emails that contain <script> tags.

l You can upload an HTML file or a ZIP file. If you upload a ZIP, Oracle Eloqua will extract the

files during the upload process.

l The maximum file size you can upload is 5 MB.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=DynamicContent
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SharedContent
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SharedContent
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SignatureLayouts


©2025 Oracle Corporation. All rights reserved 105 of 197

l Files uploaded will be scanned for malware before the upload process will complete. Any files

with malware detected will not be uploaded.

To create new emails or templates using the HTML upload wizard:

1. Navigate to Assets , then click Emails.

2. Choose the upload action:

l In the classic UI, click Upload an Email. In the wizard, choose if you are uploading an email or a

template.

l In the Redwood experience, click Actions > Upload an Email. If you are uploading a template,

choose Templates from the page selection, and then click Upload Template.

3. On the Upload HTML step, choose the file you want to upload. You can upload an HTML file or

ZIP.

4. For a Zip upload, on the Zip contents step, review the contents of the Zip. You can choose

where images should be stored. The excluded list lists files that will not be uploaded.
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5. On the Process files step,e review the list of images and other files and choose to either use

existing files or upload new ones.

For each image, you can choose an action. We will update references to the images during the

upload so that they refer to the images in the image library.

l Use Suggested Image: If an image is available in Eloqua with the same name as the image

referenced in the HTML code, we will suggest using that existing file.

l Upload New Image: If want to you want to upload a new image to replace one referenced in the

HTML code, choose this option. Then upload the new file.

l Do Nothing: Choose this option if you do not wish to change the image shown in the thumbnail. We

will upload this image to Eloqua during the upload process.

6. On the Process links step, review the links found in the HTML code. Choose the links you want

to track with a redirect or click Track All.

7. On the Finish upload step, give the final details about the email or template.

8. Click Finish to complete the upload process.

If there are any issues with the uploaded email or template, you will have to resolve them and

try to upload again.

After the upload completes, the new email or template is opened in the editor. Learn more about

the editing HTML emails using the Source Editor.

HTML email code requirements

In order for your HTML to render as expected in Oracle Eloqua and across browsers and

email clients, use the guidelines below when working with HTML in an email.
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HTML recommendations

l Always declare the DOCTYPE to ensure the best possible rendering of emails across browsers.

The DOCTYPE for HTML is <!DOCTYPE html>. For example, this declares the document to be

XHTML 1.0 Strict.

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">

l Write HTML code that is standards compliant. For example, be sure to nest and close elements

correctly, use the correct document structure (using the <html>, <head>, <body> tags), and use

lowercase element names, attributes, and values. There are various tools and browser plug-ins

that can help you validate your HTML code. For example, the W3C provides the free W3C

Markup Validation Service.

l Use of tables is encouraged for more complicated layouts. Using the <div> tag for complex

layouts will not work on many email clients. When creating tables, be sure to use the correct

HTML code structure using the tags <table>, <tr>, and <td>. Also be aware that nesting

tables with fixed widths might cause your email to display unexpectedly across different screen

sizes. Be sure to test your email across browsers and screen sizes.

l Recognize that many email clients block images by default. Because of this, include the alt

attribute in your image tag. This will be displayed instead of the image if the email client blocks

the image.

<img height="390" width="580" src="your-image.jpg" alt="This is the text
that will display" />

l Use absolute paths to reference images, stylesheets, and so on. Do not use relative references.

For files in the component library, you can get the absolute path after you upload the files.

l You can include animated GIFs and videos in your emails. Here is how Litmus describes how to

code video background in email.

l Be aware of reserved characters like <, >, and &. These characters make up the HTML

language. If you want them to appear in the content of your email, you must use the entity name

or number instead. For example &lt;, &gt;, and &amp;.

http://validator.w3.org/
http://validator.w3.org/
https://litmus.com/blog/how-to-code-html5-video-background-in-email
https://litmus.com/blog/how-to-code-html5-video-background-in-email


©2025 Oracle Corporation. All rights reserved 108 of 197

l You cannot edit dynamic content, shared content, and signature layouts in the HTML source

code editor. You must use design panel of the email editor to edit these types of content. For

more information on these types of content, see Components.

l Do not use <html>, <head>, or <body> tags within a text or shared content section. This can

create HTML code in the final email that is not standards compliant.

l Avoid using JavaScript. Most email clients do not support it for security reasons and Oracle

Eloqua might give you an error if you try to use <script> tags.

l Avoid the use of elements like <iframe> or <form> in your emails. These are not supported by

most email clients and are often blocked for security reasons. Oracle Eloqua might give you

errors if you try to use these tags in your HTML code.

CSS recommendations

l Support for CSS properties varies across email clients. Use a CSS compatibility chart to

validate what is supported.

l Do not target the <body> tag with CSS.

l Oracle Eloqua uses CSS to style the code in the Source Editor. Because of this, if you use CSS

class names that are also used by the editor, your email might not display as expected. To help

avoid this CSS conflict, avoid using the following class names in your HTML code:

l .body

l .elq-form

l .elq-form-ce

l .elq-responsive

l .hidden-border

l .inline-styled-view

l .main

l .overlays-active

l .sc-container-view

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ComponentLibrary
https://www.campaignmonitor.com/css/
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l .sc-view

l .sc-view.static-layout

l .sc-view-overflow

l Positioning like top, bottom, relative, absolutemay not display as expected across email

clients. Use tables as a more reliable way to position elements of your email.

l For proper rendering across different browsers, ensure compatibility with the following basic

Oracle Eloqua CSS reset included in the application:

html {

color:#000;

background:#FFF;

}

body,div,dl,dt,dd,ul,ol,li,h1,h2,h3,h4,h5,h6,pre,code,

form,fieldset,legend,input,button,textarea,p,blockquote,th,td {

margin:0;padding:0;

}

table {

border-collapse:collapse;

borderspacing:0;

}

fieldset,img {

border:0;

}

address,caption,cite,code,dfn,em,strong,th,var,optgroup {

font-style:inherit;

font-weight:inherit;

}

del,ins {

text-decoration:none;

}
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caption,th {

text-align:left;

}

input,button,textarea,select,optgroup,option {

font-family:inherit;

font-size:inherit;

font-style:inherit;

font-weight:inherit;

}

input,button,textarea,select {

font-size:100%;

}

Formatting HTML code in the Source Editor

You can format crowded and hard-to-read HTML code using the Auto-Format Selection

feature. This feature formats your code with standard indentations and other mechanisms

to make the code easier to read and modify.

To auto-format the HTML in an asset editor:

1. Open the email in the Source Editor.

2. In the Source Editor, highlight the code you want to format.
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3. Click Actions, then click Auto-Format Selection.

The selected code will be formatted.
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Adding preview text in the Design Editor

Most email clients display an email in the inbox with preview text. Preview text typically

displays beneath the sender and subject line and can help quickly convey the content of

your email.

Oracle Eloqua enables you to customize that preview text. Here are some things to note

about preview text:

l The preview text only appears in an recipients inbox. It doesn't appear in the email when it is

opened.

l If you do not include preview text, email clients will use the beginning of the email message as

the preview. This could include the email header and opening content of your email body.

To add a preview text to your email:

1. With your email open, choose an option:

l If you are using the Design Editor, click to open the Email Settings panel.

l If you are using the Source Editor, click Actions, then click Settings.

ZImportant: The Classic Design Editor is sunset, and all classic assets are in
view-only mode. Users can create and edit emails and landing pages with the

Design Editor or Source Editor. Learn More.

2. Add the preview text.

3. Save your changes.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502
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After you finish, validate the preview text by sending test emails to various email clients.

You cannot view the preview text using the preview tool.

Support for preview text

Most email clients support the Oracle Eloqua's implementation of preview text. Here is

some support information to keep in mind:

l The length of preview text supported varies by email client and can vary depending on the

length of the subject line. The email client could support from 35 to 120 characters.

l Preview text is not supported by all Microsoft Outlook email clients. Be sure to test your preview

text using your target email clients.
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Legacy rendering for emails

In the Oracle Eloqua email Design Editor, you can choose between legacy rendering and

the newer rendering offered by Eloqua. The new rendering uses an updated HTML

Doctype and will improve the rendering experience in email clients and web browsers. In

this topic, you'll learn about:

l Enabling legacy rendering when creating a new email

l Disabling legacy rendering for emails created prior to 20C

ZImportant: If any existing email contains custom code through code cells,

headers, footers, dynamic content, shared content, or signatures, the new

rendering might change the way the email is displayed. If you enable the new

rendering for existing emails, make sure to test what the emails look like before

sending them to contacts.

To enable legacy rendering when creating a new email:

1. Create a new email in the Design Editor.

2. Click to go into Email Settings.
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3. Under Advanced Settings, click Enable Legacy Rendering.

¤Tip: Legacy rendering is enabled when the toggle is blue.

Legacy rendering will now be enabled.

To disable legacy rendering for emails created prior to 20C:

1. Open an existing email.

2. Click to go into Email Settings.
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3. Under Advanced Settings, click Enable Legacy Rendering.

¤Tip: Legacy rendering is enabled when the toggle is blue.

Legacy rendering will now be disabled.
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Adding third-party tracking to your emails

Adding third-party tracking codes to an email

You can add an external tracking code to an individual email. This allows you to capture

email activity for a single email with your third-party provider. For example, this code

could allow you to track email opens with a third-party provider. If you need to add

tracking parameters to an email link, see Adding third-party tracking parameters to email

links.

To add external tracking to an email:

1. With your email open, choose an option:

Option Steps

If you are using

the Design Editor
a. Click to open the Email Settings panel.

b. Click Enable 3rd Party Tracking in the Tracking Settings section, and enter the

tracking code in the field below.

When you send the email, Oracle Eloqua adds the code before the closing

body element.

If you are using

the Source Editor

Paste the tracking code in the HTML pane. Refer to the provider

documentation for recommendations on where to place the code. Typically,

it is at the end of the email, before the closing body element.

2. Save your changes.
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Adding third-party tracking parameters to email links

You can automatically add third-party tracking parameters to all your email links. To do

this, you must update your email default settings.

ëNote: You must be an administrator to update email default settings.

For example, you can automatically add Google Analytics parameters to all email links so

that you can track link activity outside of Oracle Eloqua. You could use this to add the

following Google Analytics parameters to all your links:

l Campaign Source (utm_source=Eloqua)

l Campaign Medium (utm_medium=email)

l Campaign Name (utm_campaign=Eloqua-Email-Name)

http://www.example.com/index.html?utm_source=Eloqua&utm_
medium=email&utm_campaign=Eloqua-Email-Name

To add third-party tracking parameters to email links: 

1. Navigate to Assets , and click Email Setup, then Email Defaults.

2. Click the External Tracking check box and choose the analytics tool from the drop-down list.

For example, Google Analytics.

3. Click Advanced Options > Manage External Tracking.
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4. Review the configuration for the selected analytics tool.

For example, the default configuration for Google Analytics is utm_campaign=<eloqua

type="emailfield" syntax="elqWAEmailName" />&utm_medium=email&utm_

source=Eloqua.

When you send an email, Oracle Eloqua adds the parameters to all links and resolves the email

name parameter.

5. If you need to add additional parameters or customize the configuration, click Copy As New

and make your changes.

6. After saving the configuration, send a test email to verify the changes.

ëNote:

Oracle Eloqua tracks and stores the following automatic engagement metrics

separately from those generated by an actual email contact:

l Auto-opens and clicks by email scanning tools

l Apple email privacy auto-opens
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Editing the plain-text version of emails in the
Design Editor

Oracle Eloqua always generates a plain-text version of your email. The plain-text version

does not send any images, formatting, or embedded links and does not include an Oracle

Eloqua tracking pixel. It allows the email to be viewed when the HTML version cannot be

rendered properly. It is also the only version sent to contacts who prefer plain-text emails.

The plain-text version uses the text from the HTML version of the email. You can

customize the plain-text version without impacting the HTML version.

ëNote: If you want to only send the plain-text version of the email, the Source Editor

allows you to do this by updating the email settings. If you are using the Design

Editor, only contacts who prefer to receive plain-text emails will be sent the plain-

text version. Learn more about this contact preference setting.

To edit the plain-text version of an email:

1. Navigate to Assets , then click Emails.

2. Open an existing email, or create a new one. You must save your email before you can change

the plain text version.

3. Choose an option:

l If you are using the Design Editor, click Actions > Edit Plain-Text in the menu bar.

l If you are using the Source Editor, click Plain-Text.

4. To customize the plain text email, choose an option:

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/Contacts/Tasks/FlaggingContactsPlainText.htm
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l If you are using the Design Editor, click Sync with HTML email to turn off the setting.

l If you are using the Source Editor, clear the Automatically generate plain-text version check box.

5. Make your changes and save your email.
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Searching for emails

To find an email:

1. Navigate to Assets , then click Emails.

2. Oracle Eloqua provides several ways to find an email:

l Search for emails by email name or subject line.

l Use the available pre-defined filters:
l Recently Accessed

l All Files

l Created by Me

l Recently Modified

l For more advanced filtering, use the Filters tool. You can access it from All Files or from some of the

pre-defined filters. You can then use the advanced filters to by date, user, status or type.
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Copying emails

You can make a copy of an email and then change it for your current campaign needs.

When you copy the email, Oracle Eloqua copies the email settings and design. After you

make a copy, you'll want to open the copy and make sure you configure it for your current

needs.

ZImportant: Emails with links should not be copied, this can cause issues with

tracking and reporting. It is recommended to create a template without email links,

so the tracking information is not persisted to an unrelated email. If an email with

links is copied, the elqtrackIDmust be deleted and upon saving, Eloqua will

assign a unique trackID per link to the email.

¤Tip: You can also consider creating an email template instead of copying an

email. Templates are an easy way to speed up your email creation process, reduce

errors, and ensure consistency.

To create a copy of an email:

1. Navigate to Assets , then click Emails.

2. Search for the email you want to copy.
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3. Copy the email:

l In the classic UI, right-click the email and select Copy.

l

l

In the Redwood experience, click Actions > Copy.

4. The copied email appears with the word Copy appended to the name.

5. Open the copy and make the changes you need.
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Previewing emails

Previewing emails allows you to quickly validate your email content using different

contacts and screen sizes. No emails are sent when you preview and you cannot preview

using different email clients. However, previewing your emails allows you to review your

dynamic content and check how your email adapts to different screen sizes.

Previewing allows you to view your message as a recipient in desktop, tablet, or mobile

views. The preview includes the following parts of the email:

l The sender name, email address, and subject line

l The email sender's signature, populated with information based on signature rules

l The email header and footer

l All of the email content

ëNote: You cannot preview the email's preview text.

Before you begin:

l You must save your email before you can preview it.

l For emails developed in the Design Editor, review any notifications about potential responsive

issues. Notification errors appear when the email content might not adjust to all screen

sizes. Click the notification icon to view a list of all validation errors.

To preview an email:

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SignatureRules
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1. Navigate to Assets , then click Emails.

2. Open an the email or create a new one.

3. Click Actions > Preview.

ZImportant: The Classic Design Editor is sunset, and all classic assets are in view-only
mode. Users can create and edit emails and landing pages with the Design Editor or

Source Editor. Learn More.

The Preview Email window opens.

4. Search for a contact to use for the preview, then click Preview.

¤Tip: You can select multiple contacts. Use standard keyboard shortcuts to select up to
10 contacts.

5. Click the Desktop, Tablet, or Mobile tabs to view the email in different displays. You can click

to view the email in both portrait and landscape views.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502
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Sending test emails

Sending test emails can help verify that there are no issues with an email before adding it

to a campaign. Test emails appear in an inbox with "*TEST*" prepended to the subject

line.

Before you begin:

l You must resolve all draft errors before you can send the email. Draft errors appear until you

have completed all the email settings. Click the error indicator to view a list of all validation

errors.

l For emails developed in the Design Editor, review any notifications about potential responsive

issues. Notification errors appear when the email content might not adjust to all screen

sizes. Click the notification icon to view a list of all validation errors.

l You can only send test emails to contacts in your contact database.

l Activity associated to the test email (for example email opens and clickthroughs) will appear in

the email operational reports. Insight reports will not show test email activity. The activity is also

captured on the recipient's contact record.

To send a test email:

1. Navigate to Assets , then click Emails.

2. Open an existing email, or create a new one.
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3. Choose an option:

l If you are using the Design Editor, click Actions > Send Test. 

ZImportant: The Classic Design Editor is sunset, and all classic assets are in view-only mode.
Users can create and edit emails and landing pages with the Design Editor or Source Editor.

Learn More.

l If you are using the Source Editor, click Actions, then click Test Content.

4. Fill out the fields in the email checker as follows:

l Step 1. Select an email to test: The email that you have open will automatically be populated in this

field.

l Step 2. Select a User from whom to send: You can choose not to send the email from a particular

user (the default) and no signature rules will be processed. Or, you can select a user from the drop-

down list, the email will appear to have been sent from this user. This is useful if your email contains a

signature and you would like to see how the email will be generated with a specific user's signature.

l Step 3. Select a testing Email Address: This is the email address to which the test email will be sent.

Choose from recent contacts or enter a new email in the To: section. You can also use the Find

Contactand Preview Contact icons to search for and preview contacts respectively.

l Step 4. Select Test: Select the type of test you wish to perform. Typically you will want to use the

Email Checker option.
l Email Checker: Checks all the links in your email to ensure they are in the correct format. This checker also

scans the content to ensure compliance (Unsubscribe link is included and web version is available, for

example) and verify certain formatting (headers and footers are applied properly, for example).

l HTML Email: Sends the test email in HTML format.

l Text Email Sends the test email in plain text.

5. Click Perform Test .

The email is sent and the bottom pane shows the results of the test depending on the test type

you selected.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502


©2025 Oracle Corporation. All rights reserved 129 of 197

6. Review the test results for potential issues. If the email was sent successfully, the test recipients

can verify the email content from their inbox.

ëNote:

Oracle Eloqua tracks and stores the following automatic engagement metrics

separately from those generated by an actual email contact:

l Auto-opens and clicks by email scanning tools

l Apple email privacy auto-opens
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Sending batch emails

You can send batch emails directly from an email editor. This allows you to quickly send

the email to contacts as soon as it is ready. The email is added to a simple or multi-step

campaign and is sent based on the schedule you provide.

To batch send an email from the email editor:

1. Navigate to Assets , then click Emails.

2. Open an existing email or create a new one.

3. Click Actions > Batch Send:

ZImportant: The Classic Design Editor is sunset, and all classic assets are in view-only
mode. Users can create and edit emails and landing pages with the Design Editor or

Source Editor. Learn More.

4. Choose the type of campaign you want to add the email to:

l To send this email to a group of contacts, choose Simple Email Campaign. This option gives you a

straight forward wizard guiding you through the steps to send a single email. Find out more about

creating a simple campaign.

l To send the email as part of an A/B test, choose Simple Email Campaign. You can then build an A/B

test using the design wizard. Find out more about A/B testing.

l To use this email in a highly customized marketing campaign flow, click Multi-Step Campaign. This

option allows to build a more sophisticated email campaign with decision and action steps.Find out

more about creating a multi-step campaign.

5. Configure and send your email campaign.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=SimpleEmailCampaigns
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=CreateABTestingCampign
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=VerifyingCampaigns
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Stopping a batch from sending

If you need to stop a batch from sending, there are three options:

l Force Complete

l Lock Batch

l Delete Batch (Only if the batch has not sent any emails out)

Force Complete

Force Complete essentially snatches the Email Batch out of the email batch servers. All

emails that have been sent would remain sent, but any still "waiting in line" would be

instantly pulled out and marked as unsuccessful sends. However, please note that this is

an "emergency" method of stopping batches. Contacts within a campaign remain in those

steps as scheduled or In progress. Once the Force Complete is done, the batch is sealed

off and will not re-activate or send out any more emails.

Lock Batch

In the case where a batch was sent / scheduled a bit later than intended, but you'd like to

send out the rest of the emails the next day, you'd choose to lock the batch. As such,

locking it can be thought of as a "pause" that is reversible. If an email was locked at 8:00

pm, you can go back into the same batch and send it out at 8:00 am the next morning

without having to schedule a new batch.

Delete Batch

If you catch the batch before a single email was sent out, it would also be possible to

delete the batch by clicking on the delete option.
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Email Batch Control

Use the Email Batch Control page to manage your batch emails. To access to the Email

Batch Control page, navigate to Assets > Email Setup > Email Batch Control.

From this page, you can search for past batch emails and upcoming ones as well.

Use the quick search for find an email batch created in the past week.

Use the Go to Email Batch Search option to search from all email batches for all

time.
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Sending emails to a single contact

You can send an email to a single contact without setting up a campaign.

ëNote: When you send an email, the sender address is the email address

associated with your user account, not the email address specified in the email

settings.

To send an email to a single contact:

1. Navigate to Assets , then click Emails.

2. Open an existing email, or create a new one.

3. Click Actions > Email A Contact.

ZImportant: The Classic Design Editor is sunset, and all classic assets are in view-only
mode. Users can create and edit emails and landing pages with the Design Editor or

Source Editor. Learn More.

4. Search for and select the desired contact. If you need to send to more than one contact, see

Sending batch emails.

5. Click Send.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502
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Exporting email HTML

You can export the HTML for emails created in the Design Editor. The exported HTML

also includes custom CSS. This enables you to share content and utilize the output for

other use cases, giving you greater flexibility while also having the benefit of the editor.

You can also easily re-upload the HTML back into Oracle Eloqua using the Source Editor.

Prior to exporting HTML, note the following:

l Oracle Eloqua headers and footers will be exported if the Include Eloqua Elements toggle is off.

l Exported HTML does not include package images. It will always reference the images hosted in

Oracle Eloqua.

l Cloud content is removed when HTML is exported as it will not function outside of Oracle

Eloqua, and may not function if re-uploaded to Oracle Eloqua.

l Changes to exported HTML are not guaranteed to be responsive. Oracle Eloqua content spans

may not work outside of Oracle Eloqua.

To export email HTML:

1. Navigate to Assets , then click Emails.

2. Open an existing email, or create a new one.

3. Click Actions, then select Export HTML.
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4. With the Include Eloqua Elements option, you can include or exclude Oracle Eloqua-specific

elements such as dynamic content, shared content, and field merges.

l If you want to use the HTML outside of Oracle Eloqua, toggle this option off.

l If you want to re-upload and use the HTML in Oracle Eloqua, toggle this option on.

ëNote: If the Include Eloqua Elements toggle is on, and you attempt to use that HTML outside
of Eloqua, images and Eloqua-specific elements will not work.
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5. Click Export HTML File, then open or save the file.

¤Tip: You can use the Copy to Clipboard option to quickly copy and paste your HTML.

6. Click Cancel to close the Export HTML window when you are done.
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Email settings

Oracle Eloqua email settings specify information needed to send your email. Some

settings are set by default, but you can override email settings on an email by email basis.

To open the email settings:

l If you are using the Design Editor, click ,

l If you are using the Source Editor, click Actions, then click Settings.

ZImportant: The Classic Design Editor is sunset, and all classic assets are in view-only
mode. Users can create and edit emails and landing pages with the Design Editor or

Source Editor. Learn More.

The following table describes the email settings.

Setting Description

Bounceback The email address that captures bounceback responses.

Your organization may have multiple bounceback addresses. If you are

not sure what the address should be, contact your administrator.

Brands When a branded domain is set up in your account, it will link to your

chosen URL and appear in the same spot in every email. Learn more

about setting up branded domains.

ZImportant: This feature is currently released under our

Controlled Availability program. To request access to this feature,

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502
CreatingSSLcerts.htm
CreatingSSLcerts.htm
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Setting Description

please log in to My Oracle Support (https://support.oracle.com)

and create a service request.

Email Footer The email footer. The selected email group may have a default header

that you can change. Learn more about email footers.

Email Group The email group for the email. Email groups are used to manage emails

that have a common property, such as a geographic location, type of

customer, and so on. The email group determines the default headers

and footers. You can override the email group defaults without affecting

other emails in that group. Learn more about Oracle Eloqua email

groups.

¤Tip: As a best practice, do not specify an email group until after

you create your email. After you save the email, you cannot

change the email group. In order to change the email group, you

must recreate the email, then assign it to the correct group.

Email Header The email header. The selected email group may have a default header

that you can change. Learn more about email headers.

Using the Design Editor, you mange the header directly from the email

canvas. See Adding email headers and footers in the Design Editor to

learn more.

Enable Email

Tracking

Allows you to turn off tracking for the email.

Turning on tracking adds the tracking pixel to the email when it is sent.

Find out more about tracking emails.

https://support.oracle.com/
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailFooters
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailGroups
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailGroups
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailHeaders
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Setting Description

Only turn off this setting if you do not want to track email metrics for the

email and do not want to be able to report on the email's performance.

Learn more about disabling tracking.

Enable Legacy
Rendering

With this option, you can choose between legacy rendering and the

newer rendering offered by Eloqua. The new rendering uses an

updated HTML Doctype and will improve the rendering experience in

email clients and web browsers. Learn more about this setting.

This is available in the Design Editor only.

Encoding Set the character encoding to use when sending the email.

If you are using a double-byte language in the email (such as Chinese)

or may translate the content in future, set this to Unicode (UTF-8).

From Sender The display name and address for the sender. If you don't provide a

reply-to address, replies are sent to the from address.

ëNote: We recommend using an address from your

organization's domain instead of something from a public ISP like

Gmail or Yahoo!. This can help ensure the email is delivered to

the recipients inbox. For more information, see Deliverability.

Name The name for the email.

Preview Text Text to display under the sender name and subject in the receiver's

inbox. Preview text only appears in an inbox. It doesn't appear in the

email when it is opened.

Preview text is not supported by all email clients. Refer to this article for

support information.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=Deliverability
https://litmus.com/blog/the-ultimate-guide-to-preview-text-support
https://litmus.com/blog/the-ultimate-guide-to-preview-text-support
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Setting Description

Reply-to The display name and email address for replies to the email. This may

be the same as the from information.

If you don't provide a reply-to address, replies are sent to the from

address.

Send Plain-Text

only

Allows you to send a plain-text version email only.

Plain-text emails do not include a tracking pixel. Without a tracking

pixel, you can only view engagement metrics if an email link is clicked.

Some contacts may be setup to only receive plain-text emails.

Subject The email subject line. This can include field merges or dynamic

content. See Creating dynamic subject lines in the Design Editor to

learn more.

In the Design Editor, you can add Unicode currency symbols and

special characters by using the Insert menu.

ëNote: Subject lines are plain text and cannot include HTML. You

can use characters supported by the character encoding you

have selected for the email but be sure to test your emails. A

recipient's email client might not render all characters as

expected regardless of the encoding.

Virtual MTAs The Virtual MTA configuration for custom email sending options.

Virtual MTAs provide more granular control over your email sending

options, including auto bcc, IP routing, and mail relay configurations.

Although this option appears for all customers by default, only
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Setting Description

customers who have the Premium Branding and Deliverability package

will be able to take advantage of this functionality. Options for this

section are setup during the Premium Branding and Deliverability

package provisioning process. If you are not sure what Virutal MTA

should be selected, contact your Eloqua administrator.

If only one option appears in the Virtual MTAs drop-down, your Eloqua

instance does not have the Premium Branding and Deliverability

package and cannot further configure this option.

If you are interested in taking advantage of this feature, please contact

your Account Representative and ask about the benefits of the

Premium Branding and Deliverability package. Learn more.

Global email defaults

Email defaults are set up when your organization first purchased Oracle Eloqua. Some of

these settings can be set on an email by email basis, and typically you should not have to

change the default settings. For more information on individual email settings you can

change, see Email settings.

ëNote: Many of the global email default settings are read-only. If you need to make

changes, contact your Customer Success Manager or contact My Oracle Support

(https://support.oracle.com) and create a service request.

https://community.oracle.com/docs/DOC-1026741
https://support.oracle.com/
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To view global email defaults, navigate to Assets > Email Setup > Email Defaults.

Global email default settings

l Send to Specified Domains Only: Read-only. This is selected if there are no domains being

used that are not managed by Oracle Eloqua.

l Live Send: Read-only.

l Edit Allowed Email Domains: Available if Send to Specified Domains Only is selected. Click to

manage Allowed Email Domains.

l Enable Tracing: Read-only. This is only enabled if a batch investigation is happening in order

to trace individual batch steps. You can always check past batch emails and upcoming ones in

the email batch control area. Learn more.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=EmailBatchControl
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l Brand Email Domains: Read-only. Depending on the Branding & Deliverability package you

purchased, you may have one or more branded email sub-domains. Contact your Customer

Success Manager for more information. Each sub-domain is leveraged for bounceback

handling and reporting in Oracle Eloqua. These sub-domains may also be used as microsites to

host Oracle Eloqua landing pages and forms. See Microsites for more information.

l External Tracking: If you are using an external web analytics system (like Google Analytics),

you can send Oracle Eloqua email tracking information to that system. You can manage the

configurations by clicking Advanced Options. See Adding third-party tracking to your emails for

more information.

l Enable Domains for External Tracking: Click to configure domain settings for external tracking.

When in use Oracle Eloqua will not append external tracking parameters to any domains except

domains explicitly on this external tracking list. If this is enabled, you can add domains and sub-

domains to the allowlist. You can use an asterisks (*) to represent sub-domains. For example,

*.example.com would include the sub-domains your.example.com and my.example.com.

ZImportant: This feature is currently released under our Controlled Availability program. To
request access to this feature, please log in to My Oracle Support (https://support.oracle.com)

and create a service request.

l Use Approvals Workflow: Read-only. If your organization purchased the campaign approvals

add-on, this indicates whether the approval workflow is required when sending emails. Some

users might be able to bypass the approvals workflow. For more information, see Campaign

approvals.

l Add List-Unsubscribe header to outbound campaign emails (default): Enabling this option

adds a list-unsubscribe and list-unsubscribe-post header to all outbound campaign emails.

l Default Email Encoding Language: Shows the default encoding used for emails. Users can

override this on an email by email basis using the email settings. If you are using a double-byte

language in the email (such as Chinese) or may translate the content in future, this should be

set to Unicode (UTF-8).

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=Microsites
https://support.oracle.com/
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=CampaignApprovals
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=CampaignApprovals
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l Default Sender Display Name: The default display name for the email sender. You can change

this default and users can override this on an email by email basis using the email settings.

l Default From Address: The default address for the sender. This must be a valid email address.

For deliverability purposes, it is recommended that this email address has the same sub-

domain as the bounceback address. You can change this default address and users can

override this on an email by email basis using the email settings.

l Default Reply-To Address: The default address for email replies. If you don't provide a reply-to

address, replies are sent to the from address. The email address must be valid and should not

use the same sub-domain as the bounceback address. You can change this default address

and users can override this on an email by email basis using the email settings.

l HTTP X-Frame-Options Header: This option is used to determine if a browser is allowed to

render a page in an iframe, frame, and so on.

l None: No restrictions. That is, a browser would allow a client's pages that has no header to be

included within iframes, frames, and so on.

l SameOrigin: Allows a client page to be displayed in iframes, frames, and so on if these have the

same origin as the page.

l Deny: Prevents client pages from being displayed in iframes, frames, and so on.

l HTTP Referrer-Policy Header: This option is used to determine how a referrer header is

implemented on landing pages. The default selection is that a referrer header is not added. A

referrer header allows a server to identify referring pages that people are visiting from. This is

also a security protocol for prevention of tracking, stealing information, and leaking sensitive

information.

l no-referrer: The referrer header will be omitted. Sent requests do not include any referrer information.

l no-referrer-when-downgrade: Send the origin, path, and query string in Referrer when the protocol

security level stays the same or improves (HTTP -> HTTP, HTTP -> HTTPS, HTTPS -> HTTPS).

Don’t send referrer information from (HTTPS -> HTTP).

l origin: Send only the origin in the Referrer header. The origin is the scheme (protocol), host name,

and port of the URL.
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l origin-when-cross-origin: For cross origin requests (HTTPS -> HTTP), send only origin. For the same

origin requests send origin, path, and query string.

l same-origin: Send the origin, path, query string for same-origin requests. (HTTP -> HTTP) and

(HTTPS -> HTTPS).

l strict-origin: Send only origin for same-origin requests (HTTPS -> HTTPS). Don’t send the Referrer

header to less secure destinations (HTTPS -> HTTP).

l strict-origin-when-cross-origin: Send origin, path, and query string when performing a same-origin

request. For cross-origin requests, send the origin only. Don’t send the Referrer header to less secure

destinations (HTTPS -> HTTP).

l unsafe-url: Send the origin, path, and query string when performing any request, regardless of

security.

l none: If no referrer policy is set, the browser’s default policy will be used. The default policy is strict-

origin-when-cross-origin.

l Store Device Metrics: Read-only and enabled by default. If enabled, Oracle Eloqua will record

device metrics.

l Intermediate Unsubscribe Page: A landing page to present to contacts after clicking an

unsubscribe system action link. An intermediate unsubscribe page helps prevent email

scanning tools from unsubscribing contacts unintentionally. Only after confirming the

unsubscribe using the landing page will Eloqua unsubscribe the contact.

This feature is disabled by default. To enable it, select a page. Only landing pages created

using the template provided can be selected.

l Bounceback Configuration: Read-only. The email address that captures bounceback

responses.

When an email cannot be delivered because of a hard or soft bounce, the bounce response

message is sent to this address. You can use the Bounceback History with Messaging report to

view the bounce details. Depending on your Branding & Deliverability package, you may have

multiple bounceback addresses. The bounceback address should use the sub-domains

configured above. If you have multiple bounceback address, users can override the default

address on an email by email basis using the email settings.

CreatingIntermediateUnsubscribePage.htm
CreatingIntermediateUnsubscribePage.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=Bounces
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=OracleBI
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Learn more from this knowledge base article on how to change or set up a bounceback

address.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2133235.1
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Email reporting and metrics

ëNote: You must have the View Operational Reports action permission to access

operational reports.

After you've sent an email, you can use various reports and metrics to measure the

email's performance.

ZImportant: Email operational reports only report on the last 3 months of email

activity. If you need to look further back into an email's performance, use Insight

reports or Oracle Eloqua dashboards. Operational reports include test email

activity. Insight reports do not show test email activity.

Accessing operational reports from an email

You can access reports directly from an email. If you want to report on multiple emails or

a campaign, you should use Insight reports.

To access operational reports:

1. Navigate to Assets , then click Emails.

2. Open the email you want to report on.

3. Click .

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=ListOfActionPermissions
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=OracleBI
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=OracleBI
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=InsightPreview
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=OracleBI
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Overview of email operational reports

The following table describes the email operational reports:

Report Name Description
Email Link Click-Through Shows the total clickthroughs for every tracked link in the

email.
Recent Email Click-Thorough Shows the clickthroughs by date, contact, and link.
Recent Email Opens Shows email opens by date and contact. Find out more

about Calculating email opens.
Recent Email Sends Shows email sends by contact and date.
Recent Email Unsubscribes Shows all contacts that have marked the email as spam.

Overview of email dashboards and Insight reports

The following table describes the email dashboards and Insight reports:

Report or Dashboard Name Description
Email Performance Use this dashboard to view an email's engagement by

activity metrics, segment performance, activity timeline,
and click map.

Email Analysis Use this Insight report for a detailed report on the selected
email and all its metrics. With this report, you can drill
down to view the contacts associated with certain metrics.
Additionally, the report presents data for all time.

Calculating email opens

When your email assets are configured to track email opens, Oracle Eloqua matches the

email open activity with a contact record to allow you to track engagement. If there is no

open record in Oracle Eloqua for the user who opened the email, Oracle Eloqua uses

clickthroughs to "assume an email open" for email open tracking.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=EmailDetail
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Emails contain a RecipientID and a tracking pixel:

l The RecipientID enables Oracle Eloqua to associate email open activity with a contact in Oracle

Eloqua.

l The tracking pixel is a 1x1 sized pixel image that is embedded in emails by default when email

tracking is enabled. The tracking pixel is responsible for identifying opens.

ëNote: The tracking pixel is embedded at the bottom of an email by default. To request

for the tracking pixel to be placed at the top of an email, please log in to My Oracle

Support(https://support.oracle.com) and create a service request.

With these two components, Oracle Eloqua is able to count the number of email opens

and associate the email open activity with contacts. The email open counter is

incremented when a user loads email images and/or clicks a link within the email.

ëNote:

Oracle Eloqua tracks and stores the following automatic engagement metrics

separately from those generated by an actual email contact:

l Auto-opens and clicks by email scanning tools

l Apple email privacy auto-opens

Methods of calculating email opens

There are two methods Oracle Eloqua uses to calculate email opens:

l Calculating email opens via tracking pixels

l Calculating email opens via clickthroughs

https://support.oracle.com/
https://support.oracle.com/
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Calculating email opens via tracking pixels

An email open is counted when a user loads images in their email because the tracking

pixel image is loaded.

The tracking pixel image is an image tag that points to an endpoint on the Oracle Eloqua

servers and accepts the elq parameter (unique recipient id). When the image is loaded,

the endpoint records the email open against the RecipientID (which can be resolved to a

contact for reporting). The HTML snippet looks similar to this:

<img
src='http://s3.t.deven25.com/e/FooterImages/FooterImage1?elq=8a7dda673
7164d099d416d0e24d7a9b8&siteid=3' alt="" border=0 width=1px
height=1px>

If a user does not load images when viewing the email, the tracking pixel cannot be

loaded, and therefore the email open cannot be detected. In this case, Oracle Eloqua

uses clickthroughs to "assume an email open" for email opens. This helps ensure that

email opens are counted even if image loading is disabled in the email client.

Calculating email opens via clickthroughs

Eloqua uses clickthroughs to track email open activity. There are two types of

clickthroughs: website links and redirect links.

l Website links: The link click count is incremented when a link to your website within your email

is clicked. The RecipientID associated with the user is used to connect the click to the known

user back in Oracle Eloqua. Note that the target website must have tracking scripts enabled.

See Oracle Eloqua Asynchronous Tracking Scripts for more information.

l Redirect links: The link click count is incremented before the final destination web page is

loaded. There is a redirect endpoint (a point between navigating to the final browser destination

at which Oracle Eloqua is pinged so we're alerted to the behavior for tracking). This redirect

endpoint also uses the RecipientID to associate the activity to the known user.
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If a clickthrough occurs, Oracle Eloqua determines whether or not an email open

recorded for the RecipientID. If not, then an email open is also recorded along with the

clickthrough to "assume an email open".

Disabling email tracking

When your email assets are configured to track email opens, Oracle Eloqua matches the

email open activity with a contact record to allow you to track engagement. If there is no

open record in Oracle Eloqua for the user who opened the email, Oracle Eloqua uses

clickthroughs to "assume an email open" for email open tracking.

Email tracking is enabled by default. You can turn off tracking for an individual email. Only

turn off this setting if you do not want to track email metrics for the email and do not want

to be able to report on the email's performance.

To disable tracking for an email:

1. Navigate to Assets , then click Emails.

2. Open an existing email or create a new one.

3. Choose an option:

l If you are using the Design Editor, click and click Enable Eloqua Email Tracking to turn off the

setting.

ZImportant: The Classic Design Editor is sunset, and all classic assets are in view-only mode.
Users can create and edit emails and landing pages with the Design Editor or Source Editor.

Learn More.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502
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l If you are using the Source Editor, click Actions, then click Settings. Clear the Enable Email Tracking

check box.

4. Save your changes.

ëNote:

Oracle Eloqua tracks and stores the following automatic engagement metrics

separately from those generated by an actual email contact:

l Auto-opens and clicks by email scanning tools

l Apple email privacy auto-opens
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Email templates

Your organization can use Oracle Eloqua email templates to standardize on branding or

types of emails. Simply create the email in the desired email editor and save it as a

template, or upload a HTML template.

After you create a template, you can tightly manage what users can and cannot change in

the template by adding protections. This allows you to maintain consistency with your

emails and ensure required elements of the email are never deleted or changed.

ëNote: To manage templates, you must have the Manage Templates action

permission and asset permissions for the asset.

Creating email templates

You can create custom email templates for your marketing users. Using templates can

help speed up your email creation process and ensure your branding guidelines are

followed. Templates can also help your organization maintain consistency across your

marketing organization. You can add protections to your email templates to prevent users

from deleting or changing elements of an email. Learn more about protected templates.

ëNote: To manage templates, you must have the Manage Templates action

permission and asset permissions for the asset.

Before you begin:
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l This topic describes how to make a template for Oracle Eloqua marketing users. If you need to

make an email template for sales users, you create an email instead.

l You can manage access to the template using asset permissions. Marketing users can access

templates from the Template Chooser.

Creating a template

You can create a template using the Manage Templates option. This allows you to add

protections as you create the template.

To create a template:

1. Navigate to Assets , then click Emails.

2. Open the template manager:

l In the classic UI, click Manage Templates.

l In the Redwood UI, click Templates from the page selector and then click Create Template.

3. Choose a template or select Blank Template or Blank HTML Template.

l In the classic UI, choose a template, Blank Template or Blank HTML Template.

l In the Redwood experience, click on Create Templateand configure Name, Description,

Link Text, Link URL fields, and Change Icon in drawer. Then choose a template, Blank

Template or Blank HTML Template.

4. Add content to the email and update the email settings.

5. If applicable, define editable elements in the template. Learn more about protected templates.
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6. Save your template.

ëNote: The subject line and preview text are not saved as part of the template. This

prevents users from erroneously using the original information.

7. If prompted, complete the Save as Template dialog with information about the template. This

information appears for marketers in the Template Chooser when they select the template.

l You can choose to use a thumbnail of the template or use a custom icon. To use an icon,

clear the Use Thumbnail check box and choose the icon.

l To link to a web page that provides more information about the template, complete the

Text to Display for Link and URL for the Link fields. When users select the template,

they can follow the link to find out more.

8. Review and customize the template permissions. To use the template, a security group or user

must have View permissions.

If you added protections to the template, the template status is Protected. Otherwise, the

template status is Standard. After you save the template, marketing users can use the

template based on the permissions you've assigned the template.

Saving an email as a template

You can create a template by creating a new email and saving it as a template.

To save an email as a template:

1. Navigate to Assets , then click Emails.

2. Open the email or create a new one.
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3. Add content to the email and update the email settings.

4. Click File > Save as Template.

ëNote: The subject line and preview text are not saved as part of the template. This

prevents users from erroneously using the original information.

ZImportant: The Classic Design Editor is sunset, and all classic assets are in view-only
mode. Users can create and edit emails and landing pages with the Design Editor or

Source Editor. Learn More.

5. If prompted, complete the Save as Template dialog with information about the template. This

information appears in the Template Chooser window when the user selects the template.

l You can choose to use a thumbnail of the template or use a custom icon. To use an icon,

clear the Use Thumbnail check box and choose the icon.

l To link to a web page that provides more information about the template, complete the

Text to Display for Link and URL for the Link fields. When users select the template,

they can follow the link to find out more.

After you save the template, the original email remains open. If you need to change the

template, update permissions, or add protections, you must close the email and open the

template using the Manage Templates option. See Creating a template for more

information. After you save the template, marketing users can use the template based on

the permissions you've assigned the template.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=DesignEditorLandingPages
https://community.oracle.com/docs/DOC-1018502
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Adding protections to email templates

ëNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the UI.

Protected templates allow you to prevent marketers from deleting or changing elements

of an email created from that template. After adding protections, elements with

protections appear with a protected indicator.

When a marketer creates an email using the template, Oracle Eloqua identifies the

content they can edit.

To protect elements of an email template:

1. Navigate to Assets , then click Emails.

2. Open the templates list:

l In the classic UI, click Manage Templates.

l In the Redwood experience, choose Templates from the page selector.

EloquaRedwoodExperience.htm
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3. Choose an option:

Option Steps

If you are using the

Design Editor
a. Click to open the Settings panel.

b. Click Protected Content and choose what users can change:
l To allow users to change the layout settings (background image or border

settings) or the default email style, click Allow Changes to Email Style.

l To allow changes to the overall email design, such as adding or moving content

and layouts, click Allow Change to Email Design.

c. Click the content components in the email that you want to allow users to

change and click Allow Changes to Content. By default, the setting is off and

users cannot change the content component. You cannot protect a layout, but

you can prevent users from changing the settings for all layouts using the

Protected Content settings above.

If you are using the

Source Editor

a. Right-click an email element that you want to allow users to change and select

Mark as Editable.

b. Choose the options you want to enable from the Settings dialog.
l To allow users to change the element, click the Mark as Editable check box and

give the element a descriptive name. The name can help users identify the intent

of the element.

l To allow uses to remove the element from the email, click the Allow Delete check

box.

c. Click Save to close the dialog.

¤Tip: If you are using the Source Editor, you can manually add the elq-edit="true"
and elq-delete="true" attributes to elements of the email. See the reference below for

more information.

4. Click Save.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=AddHero
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After you apply protections to the template, the status of the template changes to

Protected.

Protected HTML email reference

If you are using HTML code, refer to the following table for the attributes you can use to

protect elements of your email.

Attribute Description
elq-edit="true" Defines an element as editable in a template.

Supported elements:

l Some block level elements and HTML5

elements (<article>, <aside>,

<blockquote>, <caption>, <div>,

<details>, <fig>, <figure>, <footer>,

<header>, <nav>, <section>, <summary>)

l Headers (<h1>, <h2>, <h3>, and so on)

l Images (<img>)

¤Tip: These are the supported elements.

You can try to use the attribute on other

elements, but Oracle Eloqua cannot verify

the functionality.

elq-delete="true"Defines an element as deletable. You can

apply this to the same elements listed above.
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Modifying email templates

You can change the layout and content of an email template. Changing the template

does not change any emails that were created using the template.

ëNote: To manage templates, you must have the Manage Templates action

permission and asset permissions for the asset.

To modify a template from the template manager:

1. Navigate to Assets , then click Emails.

2. Open the templates list:

l In the classic UI, click Manage Templates.

l In the Redwood experience, choose Templates from the page selector.

3. Open the template you want to change and make your changes.

Customizing email template permissions

ëNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the UI.

EloquaRedwoodExperience.htm
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After creating an email template, the creator has full permission to the template. The

creator or an administrator can customize who can view, edit, or delete an individual

email template.

ëNote: Administrators set default asset permissions. Customizing a email

template's permissions override those defaults.

l View: Allows for searching for and viewing the asset.

l Edit: Allows for changing the asset.

l Delete: Allows for deleting the asset.

l Set Security: Allows for changing the permissions for the asset.

The template will be available to marketing users if they have the View permission.

To customize template permissions:

1. Navigate to Assets , then click Emails.

2. Click Manage Templates.

3. Select the template that you want to change, then click Choose.
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4. Click Actions > Permissions.

5. Do one of the following:

l To add a user or user group to the list, click Add . 

l To remove a user or user group, click the user or group and click Delete .

6. Select the check boxes to set the permissions for the user or user group.

7. Click Save.
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Email groups

Email groups allow you to configure default settings for similar emails, including default

headers, footers, and subscription management options. If you regularly send brochures

and event emails, each of these types of messages can have their own default settings.

This makes design and deployment easier for your organization.

Using email groups (and group defaults) is an easy way to ensure visual and contextual

consistency. This can be especially valuable when you routinely deploy messages to a

set segment, like subscribers to a monthly newsletter. Consistent visual signifiers like

branding images in an email header, and agent information in the footer, can help foster

familiarity among a base audience. Moreover, keeping subscription options readily

available helps to develop a sense of transparency and trust within these

communications.

As a part of the subscription management functionality built into Eloqua, you are not able

to send an email before associating it with an email group. Having an email group defined

for each email makes it easier to manage and provide customized unsubscribe options

instead of simply defaulting to the global unsubscribe list.

¤Tip: For the latest best practices on subscription management, review our post on

Topliners.

Examples of using email groups

Administrators can create email group defaults for various group types. It's important to

consider not only the type of email included in that group, but also the target audience;

https://community.oracle.com/topliners/discussion/4478526/best-practices-evolving-email-subscription-management-processes
https://community.oracle.com/topliners/discussion/4478526/best-practices-evolving-email-subscription-management-processes
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there should be some shared relevance between the recipients to ensure an optimized

experience. Here are a few suggested group types:

l By marketing asset type: One of the more common setups is to organize email groups by the

type and instance of the marketing asset. For example, you may have different email groups for

different newsletters, notifications, PRs, emergency bulletins, and so on.

l By department: You can group the emails by the department from which they are sent. This is

particularly useful if you have several different departments sending different types of emails to

contacts. For larger companies, the top-level categories might be by department, with

functional groupings within each department area.

l By campaign: You could separate your emails into different campaign email groups. This will

make it easier for you to isolate the responses to each campaign. Again, this structure could be

within a department structure if more than one department (for instance: Marketing, Sales,

Support) is distributing email to recipients.

l By event: In some cases, particularly for larger events (such as trade shows), you may want to

have an email group for each event. In other instances, it may make more sense to organize by

the type of event, such as seminars, trade shows, and webinars.

l By user or agent: In a really large operation, you may want to allow individual marketers or sales

personnel to run their own email groups.

l By industry: If you are addressing multiple industry verticals, it may make sense to organize

email groups by different industries.

l By product or service: If you have a large catalog of products and/or services, you may want to

organize email groups by the different types of products.

l For Engage users: Email groups can be created to share email templates with Engage users.

Engage.htm
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Creating email groups

ëNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the UI.

Create an email group to easily manage content served to a targeted audience, such as

email or newsletter recipients.

Before you begin

l Define who your audience is and what the purpose of the group should be.

l Create the email headers, footers, and subscription management pages with that audience in

mind. While you can edit your subscription pages while creating the email group, it's best to

create all of your components prior to setting up your email group.

To create an email group:

EloquaRedwoodExperience.htm


©2025 Oracle Corporation. All rights reserved 167 of 197

1. Navigate to Assets > Email Setup, then click Email Groups.

2. Click . The new group appears as Untitled Email Group.

3. Configure the email group settings.

l Default Email Header: Select the default header. This header can be changed on an email by email

basis. Learn more about email headers. To choose a header, select one from the drop-down list or

click to browse to the page.

l Default Email Footer: The default footer for the email group. This header can be changed on an email

by email basis. Learn more about email footers. To choose a footer, select one from the drop-down list

or click to browse to the page.

l Subscribe confirmation page: The page that displays when a contact subscribes to this email group.

This is different than the global subscribe confirmation page. To choose a page, select one from the

drop-down list or click to browse to the page.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailHeaders
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailFooters
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l Unsubscribe confirmation page: The page that displays when a subscriber opt-outs of an email

group. This is different than the global unsubscribe confirmation page. To choose a page, select one

from the drop-down list or click to browse to the page.

l Make this Email Group available in Eloqua for Sales: Select this check box to make the group

available to Eloqua's Sales Tools users. Learn more about Sales Tools.

l Include this Email Group on the Subscription Management Page: Select this check box to include

the group on the Subscription Management Page. Recipients can reach this page by following a Send

to Subscription List system link added to an email.

When you click this check box the following fields become available to edit:

l Name of the Email Group As It Appears to Contacts: Enter the name of the group as you want it to be

displayed on the landing page.

l Description of Email Group As It Appears to Contacts: Enter a description to make it clear what types of

information this group provides. Provide a clear description to ensure that a contact who is subscribed to

several different groups will not mistakenly unsubscribe from the wrong group.

Learn more about managing contact subscription pages.

4. Click Save.

5. Review and customize the template permissions. To use the email group, a security group or

user must have View permissions.

Customizing email group permissions

ëNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the UI.

The email group creator or an administrator can customize who can view, edit, or delete

an individual email groups. You can use this, for example, to restrict access to an email

group when creating an email.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=SalesTools
EloquaRedwoodExperience.htm
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ëNote: Administrators set default asset permissions. Customizing an email group's

permissions override those defaults.

l View: Allows for searching for and viewing the asset.

l Edit: Allows for changing the asset.

l Delete: Allows for deleting the asset.

l Set Security: Allows for changing the permissions for the asset.

The email group will be available to users if they have the View permission.

To customize permissions:

1. Navigate to Assets > Email Setup, then click Email Groups.

2. Select email group you want to update.

3. Click Permissions.

4. Do one of the following:
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l To add a user or user group to the list, click Add . 

l To remove a user or user group, click the user or group and click Delete .

5. Select the check boxes to set the permissions for the user or user group.

6. Click Save.

Editing email groups

ëNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the UI.

You can edit the settings of a pre-existing email group from the settings area of the

application.

To edit an email group:

1. Navigate to Assets > Email Setup, then click Email Groups.

2. Click on the name of the group that you want to modify. Group names appear on the left, and

group settings appear on the right.

3. Change the settings as needed, then click Save to save your changes. Learn more about email

group settings.

EloquaRedwoodExperience.htm


©2025 Oracle Corporation. All rights reserved 171 of 197

ëNote: When you change the name of the email group, the name on the associated

subscription page is also updated.

To view the emails that are associated with this group, click the Emails tab for that group.

The emails are presented in a read-only list.
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Managing contact subscription pages

ZImportant: We recommend that subscription management links are included in

your emails. Privacy laws and regulations vary from country to country. Often,

commercial or relationship emails are required to provide clear and easy-to-act-

upon instructions for subscription management. Regulations around transactional

emails (such as confirmation emails) might not have the same requirements, but

again, these vary from country to country. Know and understand the rules and

regulations for the countries that you are sending emails to. Stay up to date with the

latest on international deliverability regulations by joining the Global Deliverability

group on Topliners.

Contacts can manage their subscription status on two levels:

l Email groups: Contacts can subscribe to and unsubscribe from emails on a per email group

basis

l Globally: Contacts can opt-in or opt-out from all communications at a global level

As a marketer, you facilitate this by providing links to a contact's subscription options in

the email footer of an email (or somewhere else in the body of the email). These pages

help to maintain a sense of transparency with your subscribers.

https://community.oracle.com/groups/global-deliverability
https://community.oracle.com/groups/global-deliverability
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=EmailFooters
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When a contact clicks these links, they are brought two one of two areas:

l Subscription Management Page: A system-driven web page that you configure.

l Global Opt-In or Global Opt-Out confirmation pages: Landing pages that confirm a contacts

global subscription changes.

l If you use Eloqua's unsubscribe system action link in an email, and are not sending contacts to a

subscription management page, we recommend that you setup an intermediate unsubscribe page.

This is a landing page created in Eloqua using a template we provide. When a contact clicks an

unsubscribe link, they are presented this page to confirm the unsubscribe. If you do not use this type

of landing page, contacts can be unsubscribed by email scanning tools unintentionally. To enable the

intermediate unsubscribe page, update your email defaults.

ëNote: Any settings in the master exclude list will override a contact's subscription

preferences.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=LandingPages
CreatingIntermediateUnsubscribePage.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=MasterExcludeLists
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Editing the global subscription confirmation pages

ëNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the UI.

The global subscription confirmation pages are landing pages presented to contacts

when they click an Unsubscribe from All or Subscribe to All hyperlink that you place into

your email.

When a contact changes their global subscription status changes, the change is

immediate. You can view a contact's global subscription status by viewing the contact's

preferences.

EloquaRedwoodExperience.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=LandingPages
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ëNote: After a contact globally unsubscribes, no emails are sent to them,

regardless of the email groups they may have subscribed to. However, if the

contact later globally subscribes, their original email group preferences are used.

The global email subscription status is also retained if a contact is removed from

your database. See Understanding what contact data Oracle Eloqua retains and

restores.

Before you begin:

The global subscription pages are Oracle Eloqua landing pages. Because they are

landing pages, you have complete control over the content of each page. However, it is

recommended that each page show a very clear confirmation of the contact's action. You

can brand the page and provide links to your homepage or other relevant content as

desired.

To edit the global subscription pages:

1. Navigate to Assets > Email Setup, then click Email Groups.

2. Select the global opt-in and opt-out landing pages:

l To choose a page, select one from the drop-down list or click to browse to the page.

l To view or edit a landing page, click Edit .

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ContactDataRetention
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ContactDataRetention
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=LandingPages
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3. Click Save.

Editing the Subscription Management Page

ëNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the UI.

The Subscription Manage Page is a page allowing your contacts to subscribe to and

unsubscribe from email groups. Any email group set up to be included in the Subscription

Management Page appears on the page. The page also includes an option to

unsubscribe from all emails. If a contact unsubscribes to a group, the changes are

immediate. You can verify a contact's status when you search and view contact records.

EloquaRedwoodExperience.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SearchingContacts


©2025 Oracle Corporation. All rights reserved 177 of 197

ëNote: If the contact uses the Global Opt-Out Confirmation Page, their status is

changed to "Unsubscribed Globally." This status overrides any email group

subscriptions set on the Subscription Management Page. However, Oracle Eloqua

retains the contact's email group preferences so that if its status ever changes to

"Subscribed Globally," those group preferences will take effect. The Global Opt-Out

and Global Opt-In confirmation pages are not displayed when any changes are

made to the subscription management list.

The Subscription Management Page is a static page that you modify by entering

information into the relevant fields. You can partially edit the page using HTML style tags

at the top and bottom of the page if needed.

To edit the subscription management page:

1. Navigate to Assets > Email Setup, then click Email Groups.

2. Click Edit & Preview Page.

3. Enter the information that you want to appear on the page in the corresponding fields:
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l Status Changed Text: The message that is displayed at the top of the Subscription Management

Page when a contact makes changes to their preferences. For example, "Your status has changed" or

"Your subscription preferences have been saved."

l Status Text: Text that appears at the top of the screen followed by the recipient's email address. For

example, "<You are logged in as:> user@example.com" where <You are logged in> is the text in this

field.

l Subscribed Message: Text that confirms when a contact subscribes to one or more email groups.

The text appears after they submit their changes.

l Unsubscribed Message: Text that confirms when a contact unsubscribes from one or more email

groups. The text appears after they submit their changes.

l Choose From List Text: The header text above the list of email groups available to the contact. When

a user selects a check box in this area, they opt to subscribe to that email group. For example,

"Subscribe" or "Select from these email groups."

l Unsubscribe Text: The header text above the unsubscribe check box. For example, "Unsubscribe" or

"Select this check box to unsubscribe from all email groups."

l Unsubscribe Checkbox Text: Name of the "unsubscribe from all" check box. If a contact selects this

check box, they are automatically unsubscribed from all email groups on this page (and all email

group check boxes are deselected). For example, "Unsubscribe" or "Unsubscribe from all groups."

l Button Text: Text that appears on the button a contact clicks in order to save their subscription

preferences. For example, "Save" or "Submit Changes."
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4. Enter HTML into the Top HTML Style Tags and Bottom HTML Style Tags to change the

design and layout of the top and bottom of the page.

5. Save or preview your changes.

6. Click Save after you have finished making changes, then click Close.
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Email deliverability

Email deliverability is about maximizing the potential number of emails reaching your

contact's inbox.

It should be no surprise that getting your messages to the inbox is absolutely critical

these days, especially if you’re using email as the way to kick off an orchestrated

marketing program.

Deliverability support resources

Internet service providers (ISP) are constantly making changes to ensure that their

subscribers receive emails that they actually want and that unwanted emails are sent to

the spam or junk folder. To develop a successful email marketing strategy, staying

informed of changes made by ISPs and trends can be helpful. Here are some resources

you can use to help keep you informed and seek support when you need it.

DIY Marketing Success

Boost Series

This Boost Series gives you on-demand access to modern marketing ideas and

examples by exploring best practices and strategies in a self-guided environment. The

Boost Series is available to all Oracle CX Marketing customers.

Your Customer Success Manager (CSM) can help get you started with the Boost Series

and ensure you are getting the most out of these resources.

Deliverability: DIY Marketing Success

The Do-It-Yourself Marketing Success group on Topliners provides resources and tools

that can help you learn about and execute modern marketing best practices.

https://community.oracle.com/community/topliners/
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Oracle CX Marketing Email Deliverability Guide

Access guides, webinars, and best practices on the Oracle CX Marketing website and be

sure to download the Email Deliverability Guide. This guide covers email deliverability

best practices, the ISP landscape, international regulations, and deliverability strategies.

Oracle University

Oracle University offers the following instructor-led courses to help you achieve

deliverability success:

l Best Practices: Email Deliverability

l Eloqua 10: Custom Subscription Management

l QuickCast: IP Warming Basics

Oracle Deliverability Operations support team

The Oracle Deliverability Operations support team is a global team of experts dedicated

to supporting various deliverability issues. Each individual utilizes their global and

localized expertise in email deliverability, and works with Oracle University customers to

identify deliverability issues, assist in understanding the drivers behind the issues, and

provide recommendations to address the issues going forward. If you are noticing

deliverability issues, contact My Oracle Support (https://support.oracle.com) and create

a service request.

About bounces

A bounce is an email that is returned to the sender because it was unable to reach the

recipient's inbox.

There are two different types of bounces:

https://www.oracle.com/marketingcloud/resources/email-deliverability.html
https://www.oracle.com/marketingcloud/gatedform/gated-content-overlay-content.html?elqoffer=EmailDeliverabilityGuideforMM_16
https://community.oracle.com/docs/DOC-920685
https://community.oracle.com/docs/DOC-908046
https://community.oracle.com/docs/DOC-920684
https://support.oracle.com/
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l Hard bounces

l Soft bounces

Once you send an email, you can immediately start to see bounce information. Identifying

bounces and the types of bounces can help provide insights into deliverability problem

areas. It is normal to have both hard and soft bounces, but you want to keep your overall

bounce rate below 5%. Find out more about tracking bounces.

Hard bounces

A hard bounce is an email that permanently could not be delivered. Some common

reasons for hard bounces include an invalid email address or domain name. After Oracle

Eloqua finds a hard bounce, it updates the contact's bounce status and marks the email

address as invalid. After that, Oracle Eloqua automatically excludes the contact from

future email sends.

Typically, hard bounces are returned with an Simple Mail Transfer Protocol (SMTP) code

in the 500 range. However, an internet service provider (ISP) might return a hard bounce

even if the email address is valid. In these cases, Oracle Eloqua converts the hard

bounce to a soft bounce. For example, an ISP might return a hard bounce response with

the message Blocked for spam or Too many messages on the server or it may return a

reverse DNS lookup failure error. In these cases, the email address is valid, and Oracle

Eloqua converts the hard bounce to a soft bounce.

Oracle Eloqua actively manages the logic used to convert hard bounces based on the

guideline that the email address is valid. In addition, Oracle Eloqua sometimes converts a

soft bounce to a hard bounce. Find out more about that below.

Although Oracle Eloqua does not send emails to hard bounces, you should actively

review hard bounce information. Find out more about tracking bounces and best
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practices below. If you identify contacts that were incorrectly identified as hard bounces,

you can manually change the bounce status and set the email address as valid.

qWarning: Be sure to verify that an email address is valid before resetting the

bounceback status. Continuing to send emails to hard bouncebacks can impact

your sender reputation and overall deliverability. Changing the bounceback should

always be done with caution.

Soft bounces

A soft bounce is an email that temporarily could not be delivered. This could mean that

the email address is valid, but the recipient's inbox was full, the mail server was

unavailable, or the email message was too large. These bounces may still be delivered at

another time.

Typically, soft bounces are returned with an SMTP reply code in the 400 range. If Oracle

Eloqua receives a soft bounce, it will attempt to resend the message for 48 hours in most

cases. After that, Oracle Eloqua stops sending the message. The email address remains

valid, and you can continue to send messages to this email address.

Sometimes an internet service provider (ISP) might return a hard bounce even if the

email address is valid. Oracle Eloqua converts those types of SMTP 500-level failures

from hard bounces to soft bounces. For example, failures that are due to reverse

DNS lookup failures are converted to a soft bounce.

Oracle Eloqua won't resend messages if the response indicates that the recipient's inbox

is full. This response could come with a 4XX or 5XX SMTP reply code but is always

treated as a soft bounce. The email address remains valid, and you can continue to send

messages to the address.
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Out of office messages

An out of office message is sent by an autoresponder after delivering the original email.

Oracle Eloqua does not classify an autoresponder message (link an out of office) sent to

the email’s bounceback address as a bounce. Whether the out of office message is sent

to the email’s from address, reply-to address, or bounceback address depends on how

the recipient's email application or server is configured.

For example, Microsoft Outlook sends out of office messages to the from address, and

IBM Notes (formerly Lotus Notes) sends them to the reply-to address. If an email client

normally sends out of office messages to the reply-to address, but no reply-to address is

included in the email, then the out of office message is sent to the from address. There is

no way to change the reply behavior of a recipient's email application.

Tracking bounces

It is normal for bounces to occur, but the Oracle Deliverability Operations team

recommends the following thresholds:

l Hard bounce rate: 2%

l Overall bounce rate (soft and hard): 5%

l Spam complaints: 0.2%

Best practices: Bounces

Use the following best practices to help you manage bounces and minimize the impact on

your deliverability:

l Regularly review email bounces using the reports available. Unusual spikes in bounces can

indicate an issue with your sender reputation.
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l If there are a large number of soft bouncebacks from the same domain, the bouncebacks may

have been caused by the ISP’s email throttling limits. Read this knowledge base article to find

out more.

l Consider segmenting out hard bounces. Although Oracle Eloqua will not send emails to hard

bounces, keeping your segments clean can give you more accurate contact counts when you

build campaigns.

l If you identify hard bounces outside of Oracle Eloqua, update the impacted contact records as

soon as you become are aware of the invalid address.

l Work with your sales team to determine when to delete contacts. It is important to maintain

good list hygiene, but you might not always want to delete contacts with hard bounces. For

example, maybe a contact changed jobs but is still a valuable contact. Your sales team can

follow up with the contact and update the contact details in your CRM, which would then be

synced with Oracle Eloqua.

l If you determine that you want to delete contacts, you should first export the contacts and then

delete them in a batch.

l While Oracle Eloqua prevents sending emails to contacts with hard bounces, you should make

sure that those contacts aren't exported for use by other teams or partners. Again, segmenting

out hard bounces is one way to prevent bad contact lists from being exported.

l Review the best practices in other areas and the resources available to you to help with your

deliverability.

Email Authentication

The goal of email authentication is to improve confidence in the authenticity of email

messages in order to improve overall confidence in email as a trustworthy

communications channel.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1611088.1
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Several ISPs have made it clear that in order to gain reliable delivery to the inbox, instead

of delivery to bulk or "spam" folder, authentication is required. The measures of

authentication required will vary from ISP to ISP and is determined by the individual ISP’s

policy.

Authentication can reduce the impact of spam, spoofing, and phishing attacks. This helps

protect the integrity of the domain owner's brand.

l Spoofing - method of forging another entity's identity (e.g., the "From" address) onto an email in

order to get users to open a message

l Phishing - method of tricking recipients into giving out personal information, such as credit card

numbers or account passwords, often by spoofing the origins of the email (e.g., a user's bank,

credit card company, or familiar merchant)

Several senders who have been subject to chronic spoofing and phishing issues have

declared that recipients may safely discard any email claiming to be from their domains if

valid authentication is not present in the message.

The key measures of email authentication used today are

l Sender Policy Framework (SPF)

l Domain Keys Identified Mail (DKIM)

l Domain-based Message Authentication Reporting and Conformance (DMARC)

l Transport Layer Security (TLS)

Email Deliverability

Email deliverability is all about maximizing the potential number of emails that reach

target inboxes. How well you perform depends on how your organization:

l Manages email sender reputation

l Maintains email lists
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l Ensures a quality database

l Acquires email addresses

l Manages bounces

Email deliverability and privacy matter now more than ever. New and existing laws up the

stakes for companies that don’t comply with standards and regulations. And today’s email

marketers find it increasingly difficult to be heard. You need to master deliverability and

privacy to tackle the noise generated by social media, other email marketers, and even

word-of-mouth marketing. Getting your message delivered is vital to revenue

performance.

Eloqua Branding and Configuration

Eloqua helps maximize deliverability of your email communication through a combination

of technology solutions, services/relationships, and client tactics/best practices. All new

Subscription customers receive Oracle Eloqua account(s) with a non-branded

configuration. Before sending your first campaign, your account must convert to using a

branded domain.

The main benefits of Eloqua Branding and Configuration:

l Improved deliverability. Coupled with existing Eloqua measures, it improves the likelihood of

reaching the recipient’s Inbox.

l Maintain corporate identity through sub-domain. Improved branding as email arrives from

info.client.com for example rather than en25.com.

l Remove doubt as to the origin of an email and control reputation. Only you can deploy from a

unique IP. You will establish deliverability on a subdomain that you control (rather than a

domain shared by hundreds of senders).

The main elements of branding in your Eloqua install include:
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l Branded sending From domain

l Branded bounceback envelope domain

l Branded DNS

l Branded image domain

l Branded application domains

l Branded tracking domains

l Branded microsites/landing pages

Email Authentication Setup

In this topic, you'll learn about:

l Email Sending Domain and Sub-domain Selection

l Email Bounceback Address

l Email Defaults: From and Reply-to Address

l Sender Policy Framework (SPF)

l DKIM

l Feedback Loop

l DMARC

l Transport Layer Security (TLS)

Email Sending Domain and Sub-domain Selection

The branded domain is recommended to be a sub-domain, but it can be your corporate

domain as well if configured correctly. The sub-domain(s) should be unique to Eloqua
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and will be leveraged for sending and bounceback handling and reporting in Eloqua.

Here are tips for choosing a domain/sub-domain:

l Branded sub-domains are an opportunity to strengthen your brand recognition with your

recipients. It is important to select a branded sub-domain that helps increase your brand

identity, and it should be easily identifiable with your brand. Examples that you could consider

(but replace "example.com" with your specific domain):

l response.example.com

l learn.example.com

l go.example.com

l e.example.com

l Info.example.com

l Avoid using “email”, “sales”, or “marketing” as the sub-domain or bounceback domain, because

that may subject your communications to more scanning by the receiving ISPs.

l If you have more than one brand set up for your account, you must have a unique branded

domain/sub-domain for each one. It is best if the sub-domain is not in use and has not been

used previously. Multiple brands is an add-on to your Eloqua contract. Contact your account

manager for more information.

ëNote: You should not use the same email sub-domain as your Eloqua microsite

(s).

Email Bounceback Address

Each email address will be used to capture bounceback responses to your Eloqua

system and uses the email sub-domain created for branding. Valid bounceback

responses to this email address will be captured, processed and available through the

CreatingSSLcerts.htm
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bounceback reporting tool in Eloqua (some Out-of-Office replies will be captured by this

address and will be available in the Bounceback History report).

Best practice for email sending is using the same domain for the sender From address

and bounceback domain.

For example, if your sending sub-domain is go.example.com, then your bounceback

domain could be return@go.example.com or bounce@go.example.com.

Email Defaults: From and Reply-to Address

While both the From and Reply-To Email Addresses can be set at the individual email

level in Eloqua, we configure the default settings to ensure that all of your emails are sent

with this information specific to your company.

The Default From Email Address appears in the From line in the recipient’s Inbox. It is

recommended that this email address has the same sub-domain as the bounceback

address for optimal inbox placement. Lack of consistency with domains could cause ISPs

to identify your email as spam.

The Default Reply-To Email Address is used when a recipient replies to an Eloqua email.

This email address must be a valid email address where responses can be accepted and

monitored.

ëNote: The From and Reply-to emails can be changed per email but should align

with the bounceback domain. The bounceback domain can also be changed if

multiple domains have been configured.

CreatingSSLcerts.htm
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Sender Policy Framework (SPF)

SPF is an open standard for preventing sender address forgery. Senders publish a record

in the Domain Name System (DNS). The SPF record consists of a list of IP addresses

that are authorized to send email for that domain. ISPs can then verify a sender by cross

checking the domain in the from address against the registered DNS record. By declaring

authorized IP addresses, companies can help prevent email address forgery.

As part of the DNS setup when deploying Oracle Eloqua for your organization, your IT

department created SPF records for your organization's sub-domains and Oracle Eloqua

IP addresses.

See this knowledge base article for more information on how to implement SPF.

DKIM

DKIM (Domain Keys Identified Mail) is a cryptographic signature-based type of email

authentication. DKIM requires email senders' computers to generate "public/private key

pairs" and then publish the public keys into their Domain Name System (DNS) records.

The matching private keys are stored in a sender's outbound email servers, and when

those servers send out email, the private keys generate message-specific "signatures"

that are added into additional, embedded email headers.

ISPs that authenticate using DKIM look up the public key in DNS and then can verify that

the signature was generated by the matching private key. This ensures that an authorized

sender actually sent the message, and that the message headers and content were not

altered in any way during their trip from the original sender to the recipient.

To use your corporate domain with Eloqua signature rules which sends emails on behalf

of our sales team, your IT team will need to add the public key to the corporate domain.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2133235.1
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Feedback Loop

Following DKIM setup, you should contact support to initiate the feedback loop setups.

Then the Oracle team will enable the Yahoo Feedback Loop, Microsoft SNDS, and JMRP

for your emails. This will allow you to see complaint data from these managed domains in

the SPAM Unsubscribe List report in Eloqua, and will also ensure that those email

addresses are automatically unsubscribed in your Eloqua database. Without DKIM

signing, your emails are not eligible for setup on for these feedback loops.

l As part of the initial setup, you/your IT team will receive a confirmation email as part of this

process. This email will include a link that you need to click as part of the setup process.

ëNote: The customer must submit an SR to deliverability team for completion of

setup with the feedback loop ISPs.

ëNote: Eloqua enables feedback loops for other ISPs on your behalf.

Transport Layer Security (TLS)

TLS refers to encryption of web traffic between Oracle’s server and the recipient’s server.

TLS enhances the privacy between sender and recipient.

Normal email traffic is not encrypted. This leaves the risk that snoopers could easily

intercept messages in transit. TLS ensures all communication is scrambled in such a way

that messages cannot be snooped easily.

Oracle Eloqua implements best-effort TLS for all customers so that email traffic is

encrypted whenever the remote server supports encryption.
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DMARC

Domain-based Message Authentication, Reporting and Conformance (DMARC) is a

policy based email authentication. DMARC advertises to ISP’s which support the protocol

how to treat email’s which may fail either SPF / DKIM and who might trying to phish or

spoof email’s using your brand. ISP’s lookup the DMARC record in DNS and action the

policy specified, for example you may specify to quarantine emails which fail DMARC

alignment, and to also send failure reports to a given email address. DMARCmust live in

the FROM domain’s DNS.

ëNote: Eloqua recommends that all senders use DMARC as it is an industry best

practice in regards to authenticating messages. With that said, it is important to

note that all Eloqua customers are responsible for the implementation,

configuration, and monitoring of their DMARC records & reporting. Eloqua does not

provide specific DMARC records for customers, as this process is to be completed

outside of sender’s standard configuration. Contact support for any additional

questions regarding DMARC via a My Oracle Support Service Request (SR).

IP Warming

In this topic, you'll learn about:

l Sending Reputation

l IP and Domain Warming
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Sending Reputation

l Each client/IP receives its own reputation at each ISP

l ISPs can react quickly to perceived spam patterns. Sometimes blocking senders within hours of

a campaign launch.

l Reputation over the last 30 days matters too, which is why correcting your deliverability takes

days or weeks.

l New IPs are treated with scrutiny due to lack of reputation data

l Deliverability on-boarding and IP warm up are critical for establishing a great reputation.

Key Influencers

l Bounces

l Complaints

l Volume & Consistency

l Spam Traps

l Engagement

Spikes in hard bounces or complaint rates signal deliverability problems:

l Hard bounces are a predictor of spam trap hits; this means distribution contains many old

addresses

l Abnormal soft bounce rate spikes (over typical averages) may indicate reputation-related

bulking or blocking

l Indicate end users are not expecting to receive your messages, are fatigued, or were not

properly opted in
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ëNote: Complaints are based on abuse reports received from the ISPs currently offering

feedback loops.

Volume & Consistency:

l ISP filters are configured to automatically monitor for any unusual activity to protect their users

from spam

l Sending inconsistent volumes and/or irregular volume patterns over time can trigger spam

filters and damage overall deliverability

Spam Traps:

l Spam trap hits can be one of the most damaging issues for email deliverability and maintaining

proper list hygiene is very important to avoiding spam traps.

l This requires monitoring engagement levels and removing inactive subscribers. At the very

least remove all subscribers who have not opened or clicked within the past 12 months.

l Beyond 12 months, many ISPs will invalidate inactive addresses, or convert them to spam traps

directly. Some ISPs will convert inactive addresses to spam traps after as little as 6-9 months of

inactivity.

Recipient actions that contribute to the positive engagement quotient are:

l Clicking through links

l Adding an address to their contacts or address book

l Enabling images

l Opening and/or scrolling through the message

Recipient actions that contribute to the negative engagement quotient are:
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l Reporting as spam

l Deleting the message

l Moving the message to trash

l Marking messages as read

l Ignoring messages

IP and Domain Warming

A new IP address is like applying for a credit card for the first time – no history, and

unknown risk

Once the email configuration is completed, it is essential that you slowly 'warm' your

dedicated IPs in order to create successful email deliverability and to avoid being blocked

by ISPs.

Whenever an ISP sees email traffic enter their network via an IP they have never seen

before, traffic from that IP is heavily scrutinized in order to determine if emails sent from

that IP is legitimate or SPAM. As a result, sending large volumes of email immediately via

a new IP can result in it being blocked. Other factors to consider are the number of

complaints, hard bouncebacks, and SPAM trap hits that result from these sends.

It takes approximately four to six weeks to sufficiently warm new IP addresses. During

this time, outbound emails from your IPs should gradually increase and batches closely

monitored for irregularities. Eloqua can help with the warming process on request.

l A good domain warm up should span at least 7 to 10 business days for each phase of IP

warming.

l Senders should start with their best, most engaged audience for their first sends.
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l Deliverability metrics should be monitored closely throughout this process, identifying and

acting on any issues quickly.

l Warming allows for slow volume increase, as well as clearing out list issues

l Low initial volume helps avoid volume blocks

l Limits complaint likelihood (best contacts, targeted campaign)

l Bouncebacks on low volumes get less notice

l Active contact requirement eliminates SPAM traps

ëNote: Oracle provides consulting engagements for warm-up and ramp-up

services. Oracle University offers a free course for IP Warming Basics

https://learn.oracle.com/ols/course/ip-warming-basics/37002/40400/83372#
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